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Please Note: 
Line 6, PODxt, PODxt Pro, TonePort, GearBox, GuitarPort, Line 6 Edit and Custom 
Tone are trademarks of Line 6, Inc. All other product names, trademarks, and artists’ 
names are the property of their respective owners, which are in no way associated or 
affiliated with Line 6.  
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GETTING STARTED 

Before we dive right into the world of recording, here are a few more reminders for you about keeping 
things up to date and registering your Line 6 gear… 

Updating & registering with Line 6 Monkey 

Line 6 Monkey is the intelligent updater utility that is automatically installed with your GearBox 
application. It’s a great idea to launch Line 6 Monkey every so often so you can be sure you have all 
the latest updates for all your Line 6 software and hardware products. Registering your Line 6 
hardware is also very important because it ensures that you’re dialed in for warranty service and makes 
it possible for us to contact you if new software versions or other cool enhancements are offered — 
cutting edge technology and such! So don’t put this off any longer. Connect your Line 6 hardware to 
your computer and follow these steps to launch Line 6 Monkey...  

• On Windows®, go to Start - Programs - Line 6 - Tools.  

• On Mac®, go to Applications - Line 6. 

Login account 

You’ll need to Login so that Line 6 Monkey can communicate with the online Line 6 Server and 
provide you with exactly what you need. 

• If you have a Line 6 account, then type in your User Name and Password at the top of 
the Monkey dialog.  

• If you have not yet created an account, click the New User button and you’ll get walked 
right through the steps. 

Register your hardware 

If you have not already done so, you’ll be prompted to Register your TonePort. It’s a painless 
process really, so click that Register Now button and fill in the blanks on the Web page. This 
page will list all your registered Line 6 gear in one place. 

About this guide… 

This guide is intended to provide basic setup information for TonePort and most popular audio 
recording applications. The following sections are organized by Operating System (Mac® and 
Windows®) and then by recording application. Be sure to first read through the TonePort Recording 
Setup section for Mac® or Windows® (whichever  you are using) first and then onto the section for 
your specific audio application.  Use the Table of Contents or the Acrobat®  Reader® Bookmarks at 
the left to jump directly to the desired section. Remember, more GearBox info can be found by going 
to Help > Open Help within the GearBox application, and there are a few more online documents 
the same place you found this guide, on the GearBox Online Help page.  
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TONEPORT RECORDING SETUP – MAC® OS X 

This document is designed to provide general information for configuring your TonePort device and 
GearBox software for use in different audio recording setups. Your TonePort device, since it connects to 
your Mac® via USB and includes a Core Audio driver, is easily configured to work as your computer’s 
sound card. This means that you can access all your GearBox tones directly from most any audio 
recording application, all at the highest quality! But you are of course not just limited to using TonePort 
to record into your Mac® – the outputs provided on the back of your TonePort additionally allow you to 
feed your GearBox signal to external tape machines, DAT recorders, PA systems, or whatever else will 
accept an analog line level signal. Additionally, TonePort UX2 includes a digital S/PDIF output to allow 
you to make these connections digitally!  

Using TonePort as your computer’s sound card device 

Once you have completed the GearBox software and TonePort driver installation, most everything 
you need for accessing TonePort from your audio recording/editing software is already done. A few 
helpful items for you to understand are input & output connections, audio drivers, and controlling 
your levels for recording. 

TonePort Connections 

When using TonePort UX1 or UX2 as a sound card for your audio application, to follow are the 
typical connections you’ll want to make… 
 

TonePort UX1 front panel connections 

Connect your electric Guitar or Bass  
 
 
 
 
 
 
 

 

Connect your 
stereo Headphones  
 Connect a Microphone  

 
 
Mic - To input a signal from a microphone, connect it here using and XLR cable. This inputs the 
microphone signal into GearBox where you can choose your tone, and then route the processed 
signal both to your audio software and out the TonePort outputs. 
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Guitar/Bass - To input your electric guitar or bass, plug it in here using a standard 1/4-inch TS 
instrument cable. This inputs the instrument’s signal into GearBox where you can then choose 
your tone and route the processed signal both to your audio software and out the TonePort 
outputs. 
 
Phones - If you want to listen to the audio from TonePort using stereo headphones, then plug 
them into this 1/4-inch stereo jack. This headphone jack outputs the same signal fed to the 
Analog Outs on the rear panel of TonePort; the audio from your audio software on the computer, 
as well as anything plugged into any TonePort input. 
 

TonePort UX1 rear panel connections 

 
 
 
 
 
 
 
 
 
 
 

 

Connect the Analog Outs to 
your audio monitors.   
 

Connect any line level input 
source that you want to record 
into the Line Inputs. 

Connect any line level input 
source for monitoring to the 
Stereo Monitor In. 

Connect your USB cable from 
here to your computer’s USB 
port.* 

*Note – be sure to always power off or mute your speakers or monitoring setup before connecting 
and disconnecting the USB cable between TonePort and your computer, as well as before booting 
up or shutting down your computer if TonePort is already connected. The best practice is to 
always power on your speakers last, and power them off first when connected to other audio gear 
to avoid a “pop”. 

Line Inputs - To record the signal from a line level source, such as a keyboard, your stereo 
receiver, the line out from a mixing console, etc., connect them to these Left and Right ins using 
1/4-inch TS audio cables. 
 
Monitor In - If you want to hear the signal from a line level source along with all the other 
audio coming from your computer, but do not want this audio recorded, then plug the source in 
here. Note that this is a stereo jack, so you should use a stereo 1/4-inch TRS audio cable for this 
connection.  
 
USB - This of course is where you connect the supplied USB cable to TonePort, with the other 
end going to your computer’s USB port. Note that you should always connect to a separate USB 
controller channel from other USB audio or MIDI interfaces to provide TonePort with the full 
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USB bandwidth. TonePort also gets its power from this USB connection, so it should not be 
plugged into a non-powered USB hub, or operated on the same USB controller channel with un-
powered devices. 
 
Analog Outs - These Left and Right unbalanced jacks output all the audio from TonePort; the 
audio from your audio software on the computer, and anything plugged into any TonePort input. 
These are what you want to connect to your powered speakers or monitoring system for a 
recording setup. Use 1/4-inch TS cables to connect directly to powered speakers, mixer or power 
amp setup. Note that you can also use the headphone jack on the front of TonePort if you want 
to use headphones for monitoring. 

 

TonePort UX2 front panel connections 

 
 
 
 
 
 
 
 

 

Connect your 
stereo Headphones  

Connect up to two 
Microphones  

Connect your electric Guitar or Bass

 
Microphone Inputs - You can receive input from one or two mics at the same time using these 
ins. There is also a +48V Phantom Power switch that you should toggle to “on” if your mic 
requires phantom power (most condenser type mics do, but check the documentation for your 
mic if you are not sure).  Connect each mic using an XLR cable. This inputs each microphone 
signal independently into GearBox where you can choose your tone, and then route the 
processed signal both to your audio software and out the TonePort outputs. 
 
Guitar/Bass -To input your electric guitar or bass, plug it into one of these inputs. Either of these 
routes the instrument’s signal into GearBox where you can choose your tone and route the 
processed signal both to your audio software and out the TonePort outputs. 
Norm – this input is for a standard instrument level output. Plug your guitar/bass into here using 
a standard 1/4-inch TS instrument cable. 
 
Pad - this input is designed for high output level basses and guitars, especially those with active 
pickups. Plug your high output instrument into here using a standard 1/4-inch TS instrument 
cable. 
 
Headphone - If you want to listen to the audio from TonePort using stereo headphones, then 
plug them into this 1/4-inch stereo jack. This Headphone jack outputs the same signal fed to the 
Analog Outs on the rear panel of TonePort; the audio from your audio software on the computer, 
as well as anything plugged into any TonePort input. 

 07-05-2006 Page 5



  
  GearBox 1.02 – Recording Setup Guide 

 
 

TonePort UX2 rear panel connections 

Connect your USB cable 
from your computer’s USB 

 
 

 
 
 
 
 
 
 
 
 
 
 

 

 

Connect the Analog Outs to 
your audio monitors.   

Connect any line level input 
source that you want to 
record into the Line Inputs. 
 

Connect up to two standard toggle or 
momentary pedal switches into the 
Footswitches jacks for remote control 
of GearBox and audio application 
functions  

Connect to the S/PDIF input of an 
external device to send TonePort’s 
output digitally. 

Connect any line level input 
source for monitoring to the 
Stereo Monitor In. 

 

*Note – be sure to always power off or mute your speakers or monitoring setup before 
connecting and disconnecting the USB cable between TonePort and your computer, as well 
as before booting up or shutting down your computer if TonePort is already connected. The 
best practice is to always power on your speakers last, and power them off first when 
connected to other audio gear to avoid a “pop”. 

 
Line Inputs - if you want to record the signal from a line level source, such as a keyboard, your stereo 
receiver, the line out from a mixing console, etc., connect them to these Left and Right ins using 1/4-
inch TS audio cables. 
 
Footswitches - if you want to use one or two on/off toggle or momentary footswitches to remotely 
control functions in the GearBox software, you can plug the 1/4-inch footswitch plugs into these 1 
and 2 jacks. To configure each Footswitch, go to the GearBox Preferences. You can also use these 
footswitches to trigger recording and playback commands within the included Ableton Live Lite 4 
software! For more info on TonePort Footswitches, check the GearBox Online Help page. 
 
USB - This of course is where you connect the supplied USB cable to TonePort, with the other end 
going to your computer’s USB port. Note that you should always connect to a separate USB 
controller channel from other USB audio or MIDI interfaces to provide TonePort with the full USB 
bandwidth. TonePort also gets its power from this USB connection, so it should not be plugged into a 
non-powered USB hub, or operated on the same USB controller channel with un-powered devices. 
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S/PDIF Digital Out - To send the output of TonePort to an external device digitally, connect a 75-
Ohm coaxial cable into this RCA jack and then into the S/PDIF digital input on the external device. 
This is the best choice for connecting to digital recording devices, such as a DAT recorder. This 
S/PDIF output sends the same audio as is sent to TonePort’s Analog Outs (with the exception that 
any audio coming into the TonePort’s Monitor In jack is not routed to the S/PDIF output). The 
digital signal is always sent at 24-bit resolution. 
 
Monitor In - If you want to hear the signal from a line level source mixed with all the other audio 
coming from your computer, but do not want this audio recorded, then plug the source in here. Note 
that this is a stereo jack, so you should use a stereo 1/4-inch TRS audio cable for this connection.  
 
Analog Outs - These Left and Right balanced jacks output all the audio from TonePort; the audio 
from your audio software on the computer, and anything plugged into any TonePort input. So, these 
are what you want to connect to your monitoring system when using TonePort as your computer’s 
sound card. Use either 1/4-inch TS or TRS cables to connect directly to your powered speakers, mixer 
or power amp setup. Note that you can also use the headphone jack on the front of TonePort if you 
want to use headphones for monitoring. 
 
 

Core Audio Driver  

When a sound card device is installed on your computer, a “driver” is a software component that is 
installed which allows audio applications to communicate with the device, and send audio data back 
and forth for playback and recording. Your Mac® communicates with TonePort utilizing the high 
performance Mac® OS X Core Audio driver. This allows audio applications that also support the 
Core Audio driver to take full advantage of TonePort’s high quality audio capabilities and access all 
four TonePort Record Sends as inputs for recording.  
 
The Core Audio driver also provides for extra low latency operation, which means it allows audio to 
run through your audio software in very small chunks, minimizing the delay time between input and 
output. This all provides a much more immediate response with most aspects of working in your audio 
software. 
 

Accessing TonePort as a sound card device 

Be sure to connect your TonePort to you computer’s USB port and then continue with the 
following steps. You’ll first want to launch the GearBox software and configure TonePort as the 
Playback and Recording for your Mac® System Settings. Once you make these settings, 
TonePort will also appear in most audio recording software as a selectable Playback and 
Recording device as well. 
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Go to the GearBox menu and  
select Preferences 

 
 
    

 

Go to the 
Hardware screen 
 
Choose your 
TonePort device… 
 
 
 
 
Then click the 
TonePort Driver 
Settings button 
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Go to the Audio Devices page 
Choose your TonePort device as the 
Default Input, Default Output, and in the 
Properties For slot 
 

 
You may want to leave the System Output set to the Built-in Audio, or another sound card since 
this is the device your Mac® will use to play system sounds and alerts, which you likely do not 
want to hear coming through TonePort at high volume with your music project! 
 
Format Settings - The Audio Input and Output sections both include Sample Rate and Bit 
Depth settings. 
 
Sample Rate - The sample rate that TonePort is operating at is shown in the Audio MIDI Setup 
dialog above in the Format selector for both Audio Input and Output. It is not usually necessary 
to adjust the sample rate here since it will follow the settings made in your recording software. 
TonePort natively supports both 44,100 Hz and 48,000 Hz sample rates. It is also compatible 
with the 96,000 Hz sample rate, which means that audio software can be set to operate at this 
rate and TonePort will switch to show it is using the 96000 Hz sample rate. However, TonePort 
is actually performing a high-quality sample rate conversion automatically for the 96000 Hz 
sample rate. 
 
Bit Depth - The bit depth is fixed at the 2ch-24bit for constant 24-bit operation with your audio 
software. This setting will typically work with a 16, 24 or 32 bit recording bit depth setting in 
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your recording software, and will produce the highest quality recordings. (All GearBox audio 
processing is always performed at 32 bit). 
 

Note – it is not a supported practice to “hot swap” TonePort (unplug the USB cable and plug it 
into a different USB device) while it is in use by GearBox or any other audio software. In fact, this 
just isn’t a good idea to do with any USB audio devices, since it can result in a loud pop, loss of 
sync and possibly crash or corrupt your audio software project. 

Choosing TonePort Inputs and Outputs in your audio software 

Often, all that is required is to choose TonePort in the System Settings as shown above in the 
Audio MIDI Setup dialog, and other audio software then automatically routes all its playback 
and recording settings to work with TonePort. Exactly how you access TonePort as your sound 
card from within audio software differs somewhat for each brand. Typically you’ll find a 
“Preferences” or “Audio Setup” dialog that allows choosing your driver type and device for both 
output (playback) and input (recording). For example, these settings can be accessed in the 
Preferences dialog in the Ableton Live Lite 4 application… 
 

 

 
If your audio software supports Multitrack audio recording, then it likely also allows you to 
choose specifically which input and output port to use for each audio track.  

Choosing TonePort Sends as recording inputs within your audio 
software 

The GearBox software routes your tones to “Sends” and your audio software can access these 
Sends as inputs for recording. Within the GearBox software, you can determine what actually 
gets routed to each of these Sends. This all provides you with a great deal of flexibility for 
Multitrack recording in your audio software!  
 
The Core Audio driver also allows audio software to access both “Send 1-2” and “Send 3-4”, and 
choose between them as inputs for each audio track recording. Further, the audio software will 
usually also be able to choose each individual mono Send (Send 1, 2, 3 and 4) to record a mono 
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track. Looking once again at an example in Ableton Live Lite 4, each audio track allows you to 
choose its input source – each selectable input directly refers to the TonePort Sends… 

 

An audio input selector for a track in Ableton Live. 
 
TonePort’s Sends appear as two stereo pair options and 
4 mono options. 

Choosing TonePort for playback within your audio software 

For most audio software projects, you’ll likely want all tracks, input monitoring signals and buses 
to go out to one common stereo output, so you can hear your entire mix on your stereo speakers. 
Usually just setting TonePort as your output audio device is all you need to do to make this 
happen, but in some audio software, you may need to check the outputs of your individual tracks 
as well. Similar to the above instructions, just go to the track’s output selector and choose the 
TonePort device as your output. TonePort will be available as a stereo output for playback of 
each track.  

 
 

GearBox settings and recording 

Once you are set up for recording with TonePort, then you probably will want to think about what to 
record! GearBox is all about tones, and this is where you go to set up your mic, guitar or bass tones 
that will be recorded into your audio software. To follow are basic guidelines for choosing GearBox 
settings.  
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Choosing your GearBox Source 

Once you have your mic, instrument or line level item(s) plugged into TonePort, click on the 
Source Select to choose which of these “sources” you want to create a tone for.  
 

TonePort UX1 Source Menu  

Options within this menu provide the ability to create a tone for the Mic, Analog and 
Guitar/Bass inputs separately, as well as the ability to choose a “Stereo” or “Dual-Tone” source.  
 

 

TonePort UX1 Source Select menu  
 
Stereo sources include “Stereo” in the name, 
and Dual-Tone sources include the “&” 
symbol in their names  

 

 Tone Port UX2 Source Menu 

TonePort UX2 additionally offers Source options that include its Mic 2 input.  
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TonePort UX2 Source Select menu  
 
Stereo sources include “Stereo” in their 
name, and Dual-Tone sources include the 
“&” symbol in their names 

 

Choosing Tones in GearBox 

Since there are different types of Input Sources, to follow are a few guidelines for setting up your 
tones for these types of Sources. 
 

Single Input Source   

When a single Input Source is selected, the GearBox displays the last tone preset that was in use 
for this Source. You can of course choose any preset from the Tone menu, or customize the tone 
by selecting your desired amp, preamp and effects models.  
 

Stereo Input Source 

A Stereo source accepts the inputs from the selected “Stereo” TonePort ins and processes them 
as one Stereo signal. This means that you still choose and edit one tone setting, just as you do for 
a single source, but the tone is applied to both channels, providing a stereo output.    
 

Dual-Tone Input Source 

If you select one of the Dual-Tone sources, then you are able to choose a tone independently for 
each. For example, if you want to record a performance using an instrument and a mic that are 
plugged into TonePort’s Guitar/Bass and Mic inputs, you likely want to use separate Guitar Amp 
and Mic Preamp tones. To edit the separate tone settings, use two buttons that appear at the left 
of the Tones menu – both tones remain audible regardless which tone is displayed: 
 
 
 

Two “Tone” buttons appear when a 
Dual-Tone Input Source is in use.  
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Setting up GearBox Sends 

GearBox offers two sets of stereo Record Sends which each offer independent Pan, Record and 
Monitor levels. You can think of these Sends as “virtual” outputs that are internally routed to 
both your recording software, and to the TonePort hardware outs. Your GearBox tones are 
automatically routed to these Sends and you use these Send controls to configure the stereo 
placement, recording level sent to your audio software, and monitoring level respectively. 
Setting these controls is the same for either Send 1-2, or Send 3-4. 
  

 

The Pan knob and 
Mono switch 

The Monitor level 
knob and Mute switch 

 
The Record level knob and Boost switch  

 
Pan - The Pan knob adjusts the left/right balance of the Send signal sent to the recording 
software. If you want the Input Source tone to be summed as a Mono signal, with this Mono 
signal then being routed out both channels of the Send, you can activate the Mono switch.  
 
Record level - The Record knob adjusts the level of the signal sent to your recording software, 
and directly affects the amplitude of your recorded audio. Additionally, the Boost switch can be 
activated if the signal needs an additional 18 dB of gain. The rule for recording levels and digital 
audio is to always avoid clipping, yet keep the level at least above half to capture a nice strong 
signal. Use these controls and reference the meters above to adjust this level accordingly. Your 
audio software likely has meters that will reflect this level as well. 
 
Monitor level - The Monitor knob adjusts the level of the Tone Direct Monitoring signal fed to 
TonePort’s outs. You can activate the Mute switch to mute the Tone Direct monitoring signal 
completely. These controls do not affect the Record level that is sent to your recording software. 
This allows you to balance the listening volume of your GearBox tone signal and the playback of 
tracks coming from your recording software.  
 

Note that the Output knob on your TonePort hardware will adjust the levels of your Tone Direct 
Monitoring and recording software playback for control of the overall volume of what is heard on 
your speakers. 
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Recording Send 3-4 

Send 3-4 is displayed by selecting the button in the row above the effects panel display.  
 

  

Click on Send 3-4 to 
display the Record 
Send 3-4 controls  

 
Send 3-4 is especially useful when you are using a Dual-Tone Input Source in GearBox, since 
you can then route each tone to a separate Record Send. This then allows your recording 
software to access these two tones as separate, discrete signals and record them on separate tracks 
within the same recording take.  
 

Sending audio from TonePort to an external device 

Rather than accessing the GearBox Recording Sends’ signal from TonePort as a sound card device, 
you may instead want to route your GearBox signal out to another sound card on the same or separate 
computer. Further, with all the great tones you can now create for your mics & instruments with 
GearBox, there is no need to limit them to the inside of a computer!  You may also want to send the 
signal to external hardware such as an analog or tape Multitrack unit, a DAT or video tape recorder, 
or even to an amplifier or P.A. system for live performance.  To follow are instructions for these 
different types of setups. 
 

Connecting analog outputs from TonePort/GearBox to an 
external device  

You can route your tones from TonePort/GearBox to just about any type of external device 
simply by connecting the Analog Outs from the back of your TonePort UX1 or UX2 directly 
into the external device’s line level inputs. This allows you to amplify or record your GearBox 
signal using any external device that accepts analog line level inputs.  
 
 

 

Connect TonePort’s Analog Outs to the 
analog inputs on any external audio device 
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Routing TonePort’s analog outputs to another sound card 

If you want to use TonePort/GearBox in a computer recording setup where a multi-input sound 
card already exists, then you might find it useful to connect TonePort’s Analog Outs into two of 
the analog inputs of the existing sound card. This allows you to use the existing sound card with 
your recording application to also receive additional discrete inputs directly from other sources at 
the same time, if this is the preferred setup. When TonePort is connected to another sound card 
this way, then you will want to be sure your recording software is set to use the other sound card 
as its input device for recording. In this configuration, since TonePort is not acting as a sound 
card device, the TonePort’s Analog Out signal is what is being recorded, and therefore, levels are 
controlled by the GearBox Monitor level and TonePort Output knob.  

 

Connecting the S/PDIF Digital Output from TonePort 
UX2/GearBox to an external digital device  

TonePort UX2 also includes an S/PDIF digital output, which allows you to connect to digital 
devices such as a DAT recorder, MiniDisc, another sound card, or most any device that offers an 
S/PDIF format digital input. This is the preferred method to connect to external devices since it 
does not require the added digital-to-analog-to-digital signal conversion process as required with 
using analog outs.  
 
Digital clock settings - When connecting to a digital device in this manner, one device needs to 
sync to the “digital clock” of the other, and preferably both should also operate at the same 
sample rate. To configure this correctly, you’ll need to look for a “clock” setting on the digital 
device you are connecting to and set it to “External” or “S/PDIF” so that it follows the digital 
clock of your TonePort rather than its own internal clock. If you are connecting to the S/PDIF 
input of another sound card, this can be either a hardware switch on the unit, or an option found 
in the software control panel for the device. As an example, when connecting TonePort UX2 
digitally to a Digidesign Mbox for recording in Pro Tools LE, you access the Mbox clock settings 
within the Pro Tools Hardware Setup dialog:  
 

 

Setting the Digidesign Mbox to 
“follow” the TonePort S/PDIF 
clock and receive S/PDIF 
digital input for recording  
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Sample rate - Since TonePort UX2 is acting as the “master” clock device in this scenario, you 
should also manually set the desired sample rate for TonePort, so that the sample rate matches 
the one set on the external device. This is done in the Format options within the Audio MIDI 
Setup dialog. You will want to choose 44100 Hz or 48000 Hz. 
 

 
 
 
 
Setting output levels for the S/PDIF output - The S/PDIF output of TonePort UX2 always 
receives the same GearBox audio content as is heard at the Analog Out and Headphone out, 
(with the exception that any audio coming into the TonePort’s Monitor In jack is not routed to 
the S/PDIF output). When devices are connected digitally, typically the receiving device does 
not include a level control to adjust the level at input. Therefore, you’ll want to set the level 
from the GearBox software, if necessary, to optimize your recording level. The GearBox Monitor 
knob controls the level going out of S/PDIF output. You’ll want to keep this level as high as 
possible, without clipping, for the best fidelity. Note that the GearBox Mute button also mutes 
the S/PDIF output. 
 
 
Other considerations when using S/PDIF output 
 

• Some digital devices may only support one sample rate (some DAT and video machines 
are fixed at 48 kHz for example), so you will want to be sure to choose a sample rate 
supported by both units. 

• When TonePort UX2 is operating in its 96 kHz “compatible” sample rate mode, it sends 
data out the S/PDIF at 48 kHz. The S/PDIF output is always sent as 24 bit. 

• Remember that if you are connecting TonePort UX2’s S/PDIF output to another sound 
card, you are not limited to the other sound card being on the same computer. You can 
use TonePort/GearBox as for your tone and then send it digitally to a completely 
different setup for recording! 

 

Mac® OS X System Preferences 

There are a few System Preferences that you should configure when using your Mac® for audio 
recording. Launch the Mac® OS X System Preferences dialog to make the following settings. 
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System Sounds and Alerts 

When using TonePort, you likely will not want to hear these sounds, and you certainly don’t 
want to end up recording them by mistake! You can adjust the volume independently for these 
system sounds and alerts by going to the Sound page. 

 

 

Choose Sound in the 
System Preferences 
dialog 
 

 

 

In the Sound Effects page, 
adjust the Alert volume 
slider down, and uncheck 
the Play user interface 
sound effects checkbox 
 

 
 
 
Energy Settings 
It is also a good idea to configure your Energy settings so that critical computer components do 
not go to “sleep” or run at less than full  

 

 

Choose Energy Saver in the System 
Preferences dialog 

 07-05-2006 Page 18



  
  GearBox 1.02 – Recording Setup Guide 

 
 

 

 

Choose Power Adapter *  

 
Set the top slider all the way to Never so that the computer is 
not allowed to enter “sleep” mode. 
 

 
 
 
 
 
 
 
 

 

* You can also select Battery if you have a laptop and repeat all the steps in this section, but 
you may want your settings to conserve battery power, or may not use the machine for audio 
work when running on battery. 

Go to the 
Options page 
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CONFIGURATION AS AN AGGREGATE DEVICE -  MAC® OS X 

Combine TonePort with other Core Audio devices using the Mac® OS X Aggregate Device feature  

 
A feature introduced by Apple in the OS X Tiger (10.4) version is the ability to configure two or more 
Core Audio sound card devices into one Aggregate Device. As the name suggests, this makes it possible 
to combine multiple connected audio devices allowing audio applications to utilize all inputs and outputs 
as one virtual Core Audio device. The Aggregate Device feature also provides the ability to sync the 
devices, and resample if needed to allow them to work together with your audio applications. This can be 
quite useful if you have another Core Audio sound card and want to use TonePort along with it to 
provide additional inputs for recording, or additional outputs for sending multiple playback or 
monitoring mixes. 
 
For this document, we’ll be showing you how to create a simple Aggregate Device using TonePort and a 
Built-in Audio device. The steps are similar for combining TonePort with other models of audio devices, 
as long as they offer a Core Audio driver that supports this OS X feature.  

 

Note – It is not supported to use TonePort with other Line 6 USB hardware to build an 
Aggregate Device. It is also not advised to ‘hot swap” (unplug the USB cable from one USB 
audio device and plug it into another) TonePort while in use by GearBox or other audio 
software. 

Be sure to connect the USB cable from TonePort into your computer’s USB port, and then proceed with 
the following steps… 

      

Creating an Aggregate Device 

All the required settings you need to make to create an “Aggregate” device are made within the 
Aggregate Device Editor window, which is found in the Audio MIDI Setup dialog. Launch the 
GearBox software and go to the Help menu to launch the Audio MIDI Setup… 
 
 

 

Go to the GearBox Help menu and choose 
Hardware & Driver Settings 
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In the Audio MIDI 
Setup dialog, choose the 
Audio Devices page 

   
  
 

 

Go to the Audio menu 
and choose Open 
Aggregate Device 
Editor  

 
 
As soon as you click the Add (+) button, a device will be created for you to configure, listing all of 
your individual connected Core Audio devices within the Structure pane. You can also edit the name 
for this Aggregate Device in the top pane if you like. 
 
 

 

Click on the “+” button to create 
a new Aggregate Device 
 
 
 
 
All detected Core Audio devices 
are listed in the Structure pane 
  

Note that the numbers of In and Out ports are listed for each device 
 
 
 

 
In the Aggregate Device Editor, you can click the Add button to create as many Aggregate Devices as 
you like, and each can be configured to use the individual audio devices you choose.  
 
None of the individual audio devices are activated until you check the Use box to the left. We’re 
going to click the Use buttons for both these audio devices, which will create an Aggregate Device 
with a total of 6 inputs and 4 outputs.  
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Click on the Use boxes for both 
Audio Devices to activate them. 
(Click TonePort’s Use box first 
to make it the first device in the 
list) 
 
Click on the TonePort Clock to 
set it to act as the Clock device. 
Your TonePort MUST always 
be set as the Clock when 
creating an Aggregate device. 

Keep the Resample checkboxes unchecked 
unless necessary* 

 
When creating an Aggregate Device, only one audio device can be designated as the “Clock”. This 
means that this device acts as the “master” and all other devices follow its digital clock, thus keeping 
all your audio in sync. Even though the Aggregate Device dialog allows you to set any individual 
Audio Device as the Clock, TonePort is designed to only function as a “master” audio device. Be sure 
that TonePort is set as the clock as shown in the previous figure to ensure proper sync.  
 
 

*The Aggregate Device Resample function - When combining audio devices, the sample rates 
must match to allow them to be used together. But if you run into sync problems when using 
some devices together, or in the case where you need to choose a sample rate not supported by 
all audio devices, you can check the Resample checkbox for the device. This instructs the 
Aggregator to automatically perform a sample rate conversion to allow the audio devices to sync. 

 
 
 
 
 

Note – TonePort natively supports 44100 and 48000 Hz sample rates. It will also support 96000 
Hz, but will perform its own sample rate conversion process to do so.   

 
 

Once above settings are made, click the Done button to return to the Audio MIDI Setup dialog… 
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You are now able to choose this new “Aggregate Device” in the menus of the System 
Settings. Choose your new Aggregate Device as the Properties For device.  

 
 
 

 
 
 
 
 

 
 
The Audio Input and Audio Output sections each have a selector to allow you to choose each Stereo 
device, and then make settings for each with the set of controls below. 
 

 

Once you have selected the Aggregate Device in the Properties For selector, you will 
then be able to access settings for all combined inputs and outputs! For the device we 
created, this totals 6 Audio Inputs and 4 Audio Outputs. 

You will now see all devices’ inputs in 
the Audio Input selector. Likewise, you 
will see all outputs in the Audio 
Output selector. 
 

 

 07-05-2006 Page 23



  
  GearBox 1.02 – Recording Setup Guide 

 
It is helpful to take note of the order of how all these Inputs and Outputs appear in the Audio MIDI 
Setup dialog. In our example, TonePort’s Send inputs are listed first because we made it the first 
device in the Aggregate Device Editor. The “Stream” input is from the Built-in Audio Device, and 
appears last. These input and output ports will also appear in this same order within your audio 
recording software, but likely will not have any other identifying name other than their order 
number. 
 

Using an Aggregate Device with audio recording software 

Once an Aggregate Device is created, you should then be able to access it in your recording software. 
To follow we’ll show how the Aggregate Device we created in the previous steps appears in the 
included Ableton Live Lite 4 software… 
 
Launch the Ableton Live Lite 4 software and open the Preferences dialog to configure the audio 
device. 

 

Go to the Live menu and 
choose Preferences 
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Go to the Audio tab 
 
Choose CoreAudio as the driver 
type… 
 
Then choose the Aggregate Device 
that was just created for both the 
Input and Output Audio Device. 
Note that this appears along with the 
individual audio devices in these 
menus as an additional selectable 
device. 
 
Set a Sample Rate – preferably this 
should be one supported by all the 
audio devices that make up your 
Aggregate Device. 

Just as with most Multitrack recording software, in Live you also need to configure the 
individual inputs and outputs once a Multi-in/out device is selected. Click on the Input 
Config button to access the Inputs. 
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By default, Live will usually 
have only the first device 
enabled. Click on all the 
non-active devices here to 
allow them to all be available 
as recording inputs in the 
Live software 
 
Click OK when done 
 

    

As noted earlier, you’ll need to refer to the order of the devices in the Audio MIDI Setup 
dialog to know which are TonePort Ins, and which are from the other device since Live 
does not show the individual device names. 

 
      
Next click the Output Config button in the Preferences dialog to similarly activate the multiple 
outputs… 
 

 

Click on all non-active 
output devices to make 
them available as playback 
outputs in Live* 
 
 
Click OK when done 

 

 

*Note - The Ableton Live Lite 4 version has a restriction that allows only one stereo output 
to be used at a time. To be able to choose two or more different output devices in a Live Set, 
you must switch into Demo mode, or upgrade to a full version of Ableton Live 

 
     
 
You can now continue to use Ableton Live and all inputs and outputs will appear within the audio 
track menus, just as if all exist on one sound card! 
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For more information regarding the Aggregate Device feature, check your Mac OS X documentation.

All inputs appear in the 
Live audio track input 
menu 

 
 
 
 
_________________________________________________________________________________ 
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ABLETON LIVE LITE 4, LINE 6 EDITION SETUP – MAC® OS X 

Be sure to connect the USB cable from TonePort into your computer’s USB port, and then proceed 
with the following steps… 
 

Configure your Mac® to use TonePort as your audio device 

First launch the GearBox application, and then go to the GearBox menu to launch the Preferences 
dialog. 
 

 

Select the GearBox menu and choose Preferences 
  

 
 
    

 

Choose the Hardware 
page 
 
Select your TonePort 
UX1 (or UX2) device… 
 
 
 
 
 
Then click the TonePort 
Driver Settings button 
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 1 1 7 Now launch the Pro Tools LE application and create a new

Choose your TonePort device in the Properties For selector, and then match the all the 
Audio Input and Audio Output settings shown here 

 
 Note that setting the System Output to your Built-in Audio device will result in your Mac 

system and alert sounds playing through this device. When using TonePort, you likely will 
not want to hear these sounds at all. You can adjust the volume independently for these 
sounds by going to the Mac System Preferences > Hardware – Sound option > Sound 
Effects button… 

 
 
 
 
 
 

 
 

 
 

Adjust the Alert volume slider down, and uncheck the Play user interface 
sound effects checkbox 
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Configuring Ableton Live Lite 4 to use the Core Audio TonePort driver 

Launch Ableton Live Lite and make the following settings… 
 
  

 
 

 
  

 

Select Ableton Live’s  
Live menu and choose 
Preferences 
 

When above settings are 
complete, click the Input 
Config button  
 
 

 
 
Choose a Sample Rate – 
44100 is a good choice for 
most projects 
 

Select the Audio tab 
 
Choose CoreAudio as the 
Driver Type  
 
Choose TonePort UX1 (or 
UX2) as both the Input 
and Output Audio Device 
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Click on the 3 & 4 
(mono) and the 3/4 
(stereo) Input buttons to 
activate them if you will 
want to record from 
TonePort Sends 3 and 4 
into Live 
 
Click the OK button to 
exit the dialog 

 
 
 
 
 
 
 
You can choose either 
AIFF or WAV as your 
File Type – AIFF is best 
for Mac compatibility, 
and WAV best for 
Windows application 
compatibility  
 
Choose 24 as the Bit 
Depth 

 
 

Select the Misc tab  

Select the close button to exit the Preferences dialog once these 
settings are complete. 

 
This completes the Audio Driver configuration! 
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Setting up an audio track to record from TonePort in Ableton Live 

Now that your TonePort hardware is set up, you are ready to start working in a new Live Set! Open or 
create a new Live Set and make the following settings… 
 

 

Click the Session 
View Selector to 
switch to the Session 
View  

 
 
 
 

 

The In/Out  
settings group 

Click the Show/Hide 
In/Out Selector to 
display this group of 
settings in the Mixer 
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Click the Monitor Off 
button for the Audio 
Track you wish to 
record into 

 

 

Select Ext. In as 
the Audio From 
setting 

 

 

Select the Input Channel: 
 

-1/2 will record from TonePort Sends 1 & 2 as a Stereo file 
 

-3/4 will record from TonePort Sends 3 & 4 as a Stereo file 
 

-1, 2, 3 or 4 will record from the respective TonePort Send as a 
Mono file 

 
 

   

Click on the Arm switch to arm 
the track for recording 
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Click the Arrangement 
View selector to switch to 
the Arrangement View 
display  

 
Click the Global Record 
Button to prepare the 
Live Set for recording  

 

 
 
 Click the Play 

Button to start 
recording!  

 
 

For more information, try the Lesson within the Help menu of Ableton Live Lite 4 for Recording 
with Live and TonePort… 
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ABLETON LIVE 5 SETUP – MAC® OS X 

Be sure to connect the USB cable from TonePort into your computer’s USB port, and then proceed with 
the following steps… 

 

Configure your Mac® to use TonePort as your audio device 

First launch the GearBox application, and then go to the GearBox menu to launch the Preferences 
dialog. 
 

 

Select the GearBox menu and choose Preferences 
  

 
 
    

 

Choose the Hardware 
page 
 
Select your TonePort 
UX1 (or UX2) device… 
 
 
 
 
 
Then click the TonePort 
Driver Settings button 
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1 1 6 Now launch the Pro Tools LE application and create a new

Choose your TonePort device in the Properties For selector, and then match the all the 
Audio Input and Audio Output settings shown here 

 
Note that setting the System Output to your Built-in Audio device will result in your Mac 
system and alert sounds playing through this device. When using TonePort, you likely will 
not want to hear these sounds at all. You can adjust the volume independently for these 
sounds by going to the Mac System Preferences > Hardware – Sound option > Sound 
Effects button… 

 
 
 
 
 
 

 
 
 

 
 

Adjust the Alert volume slider down, and uncheck the Play user interface 
sound effects checkbox 
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Configuring Ableton Live 5 to use the CoreAudio TonePort driver 

Launch Ableton Live and make the following settings… 
 

 
  

 
 
 

 

Select the Audio tab 
 
Choose CoreAudio as the 
Driver Type  
 
Choose TonePort UX1 (or 
UX2) as both the Input 
and Output Audio Device 
 
Choose a Sample Rate,  
44100 is a good choice for 
most projects 
 
When above settings are 
complete, click the Input 
Config button  
 
 

Click on the 3 & 4 
(mono) and the 3/4 
(stereo) Input buttons to 
activate them if you will 
want to record from 
TonePort Sends 3 and 4 
into Live 
 
Click the OK button to 
exit the dialog 

Select Ableton Live’s  
Live menu and choose 
Preferences 
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Select the Defaults tab  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can choose either 
AIFF or WAV as your 
File Type – AIFF is best 
for Mac compatibility, 
and WAV best for 
Windows application 
compatibility  
 
Choose 24 as the Bit 
Depth 

This completes the Audio Driver configuration! 

Select the close button to exit the Preferences dialog when all settings 
are complete 
 
 

  
 
 

Setting up an audio track to record from TonePort in Ableton Live 

Now that your TonePort hardware is set up, you are ready to start working in a new Live Set! Open or 
create a new Live Set and make the following settings… 
 

 07-05-2006 Page 37



  
  GearBox 1.02 – Recording Setup Guide 

 

 

Click the Session View 
Selector to switch to 
the Session View  

 

 

The In/Out  
settings group 

Click the Show/Hide 
In/Out Selector to 
display this group of 
settings in the Mixer  

 

Click the Monitor Off 
button for the Audio 
Track you wish to 
record into 
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Select Ext. In as 
the Audio From 
setting 

 
 

 

-1/2 will record from TonePort Sends 1 & 2 as a Stereo file 
 

-3/4 will record from TonePort Sends 3 & 4 as a Stereo file 
 

-1, 2, 3 or 4 will record from the respective TonePort Send as a 
Mono file 

Select the Input Channel: 
 

 
 

  

Click on the Arm switch to arm 
the track for recording 

   
 
 

  

Click the Arrangement 
View selector to switch to 
the Arrangement View 
display  
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Click the Global 
Record Button to 
prepare the Live Set for 
recording  

 
 
 

 Click the Play Button to start recording!  
 

 
 
 

_____________________________________________________________________________________ 
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APPLE GARAGEBAND 3 SETUP– MAC® OS X 

The following steps show you how to configure TonePort UX1 or UX2 with Apple GarageBand. The 
steps are the same for configuring GarageBand version 2 or 3. Be sure to connect the USB cable from 
TonePort into your computer’s USB port, and then proceed with the following steps… 

 
Configure your Mac® to use TonePort as your audio device 

First launch the GearBox application, and then go to the GearBox menu to launch the Preferences 
dialog. 
 

 

Select the GearBox menu and choose Preferences 

 
 
    

 

Choose the Hardware 
page 
 
Select your TonePort 
UX1 (or UX2) device… 
 
 
 
 
 
Then click the TonePort 
Driver Settings button 
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1 1 5 Now launch the Pro Tools LE application and create a new
Choose your TonePort device in the Properties For selector, and then match the all the 
Audio Input and Audio Output settings shown here 

 

Note that setting the System Settings - System Output to your Built-in Audio device 
will result in your Mac system and alert sounds playing through this device. When 
using TonePort and creating your musical masterpieces, you likely will not want to hear 
these system sounds blaring through your speakers or headphones at all! You can adjust 
the volume independently for these sounds by going to the Mac System Preferences > 
Hardware – Sound option > Sound Effects button… 

 
 
 
 
 
 
 

 
 
 
 

 
 

Adjust the Alert volume slider down, and uncheck the Play user interface 
sound effects checkbox 
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Configuring GarageBand to use the TonePort driver 

Launch GarageBand and make the following settings… 
 
  

 
 
 
 
 
 

 
 
 
 
 
 
 

 

Select TonePort UX1 (or UX2) as the Audio Output. This will immediately launch a prompt 
asking if you want to change the audio driver… 

Click the Yes button to 
change the audio driver 

Select the GarageBand 
menu and choose 
Preferences 
 

Select the Audio/MIDI button 
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Once the driver initialization process completes, choose your TonePort UX1 (or UX2) as 
the Audio Input  

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

Once again, if prompted, click Yes to change the audio driver 

Click the close button at the top left of the Audio/MIDI dialog once all 
these settings are complete. 
 
This completes the Audio Driver setup!  

 
 

Setting up an audio track to record from TonePort in GarageBand  

Now that your TonePort hardware is set up, you are ready to start working in a new project! Open or  
create a new song project and make the following settings… 
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Select the Real Instrument button,  
then choose Basic Track  

Select the GarageBand Track menu and 
choose New Track  
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Click the Create 
button when done 

Set the Monitor 
option to Off 

Select the desired 
Input for the track*  
 

 
 
 
 
 
 
 

* The Channel 1 & 2 and Channel 3 & 4 options will receive input from TonePort Sends 1 
& 2 and Send 3 & 4, respectively, and will record a stereo file.  
 
The individual Channel 1, 2, 3 and 4 options will receive input from TonePort Send 1, 2, 
3 or 4, and will record a mono file.

 
 
 

 
 

Note that the track 
meters measure the 
TonePort/GearBox 
input signal once the 
track is armed 
 

Select your new audio track and click on the track’s Arm button  

 
 
 

 

 

Click on the 
transport Record 
button and start 
recording! 
 

 
 

_____________________________________________________________________________________ 
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APPLE LOGIC EXPRESS 7 SETUP – MAC® OS X 

Be sure to connect the USB cable from TonePort into your computer’s USB port, and then proceed with 
the following steps… 

 

Configure your Mac® to use TonePort as your audio device 

First launch the GearBox application, and then go to the GearBox menu to launch the Preferences 
dialog. 
 

 

Select the GearBox menu and choose Preferences 
  

 
 
    

 

Choose the Hardware 
page 
 
Select your TonePort 
UX1 (or UX2) device… 
 
 
 
 
 
 
Then click the TonePort 
Driver Settings button 
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Choose your TonePort device in the Properties For selector, and then match the all 
the Audio Input and Audio Output settings shown here 

Note that setting the System Output to your Built-in Audio device will result in your Mac 
system and alert sounds playing through this device. When using TonePort, you likely will 
not want to hear these sounds at all. You can adjust the volume independently for these 
sounds by going to the Mac System Preferences > Hardware – Sound option > Sound 
Effects button… 

 
 
 
 
 
 
 

 
 

 
 
 

Adjust the Alert volume slider down, and uncheck the Play user interface 
sound effects checkbox 
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Configuring Logic Express to use the Core Audio TonePort driver 

Launch Logic Express and make the following settings… 
 
  

 
 
 
 
  

 

Select the Audio page 
 
Choose the Driver tab 
 
Check the Enabled 
checkbox – this will 
immediately launch a 
prompt to reboot Logic 
Express… 
 
 
Click the Try (Re)Launch 
button.  
This will attempt to reset 
the driver without actually 
exiting Logic Express. 
 
 

Select the Logic Express 
Audio menu and choose 
Audio & Hardware Drivers 
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The Try (Re)Launch process 
will display a Progress meter as it 
initializes the driver – allow this 
process to complete. 

Select the General tab  
 
You can choose either 
AIFF or WAVE as your 
Recording File Type 
 
AIFF is best for Mac 
compatibility; WAVE is 
best for Windows 
application compatibility 

Once the driver 
initialization process 
completes, choose your 
TonePort UX1 (or 
UX2) as the Driver 
 
Check the 24 Bit 
Recording checkbox 
 
Uncheck the Software 
Monitoring checkbox 
 
All other settings in this 
Drivers tab display can 
remain using the default 
values as shown  

Select the close button at the top 
left of the Preferences dialog to 
exit once these settings are 
complete.  
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Setting up a Logic Express Project for recording with TonePort 

Now that your TonePort hardware is set up, you are ready to start working in a new Project! Open or 
create a new Project and make the following settings… 
 
 

 

Select the Logic Audio 
menu and choose a 
Sample Rate.  
 
44100 is typically a good 
choice, but you can 
choose another if your 
Project has specific 
requirements.  

 
 
 
 
All audio track settings can be made within the Inspector panel at the bottom left of the Arrange 
window – this always shows the settings for the selected track… 
 

 

First, click the 
Mono/Stereo button 
to set the desired 
format for the track 
and your recorded file 
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Click the Input 
Selector button and 
choose the desired 
GearBox Send as the 
track input 

 
 
 
 
 
 

If you choose a Stereo track, then you will see “paired” options for Input 1-2 and Input 3-4.  
 
For a Mono track you will see individual Inputs 1, 2, 3 and 4. All inputs refer to the GearBox 
Sends of the same number. 

 
 

 

Click the Output 
Selector button 
and choose Output 
1-2. 
This assigns the 
track output to 
your TonePort 
device. 
 
Click the REC 
button to arm the 
selected track for 
recording 
 

 
 
 

Note that when the track is armed, the track meters measure the input level coming in 
from GearBox.  
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Once the above settings are made, just click the transport Record button and start 
recording! 

 
 
 
 

Using Footswitches with TonePort UX2 and Logic Express or Pro 7 

You can utilize one or two footswitches plugged into TonePort UX2’s Footswitches jacks to remotely 
control transport functions in Logic 7. This can be quite handy for hands-free operation when recording!  
 
Be sure to connect the USB cable from TonePort UX2 into your computer’s USB port, and then proceed 
with the following steps… 

 
 
Connect a footswitch (or two)  
TonePort UX2 offers two independent 1/4-inch jacks for connecting standard footswitch pedals.  
 

 

Connect up to two footswitch pedals into 
these Footswitches 1 & 2 jacks 
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Configure Logic Express/Pro 7 to respond to your Footswitches 
Launch Logic and go File > Song Settings > Synchronization. 
 
 

  

Go to Logic’s File menu and 
choose Synchronization 
 

 

 

Go to the MIDI 
tab  
 
 
 
 
 
 
 
Check the box for 
Listen to MMC 
Input  
 
Exit the Song 
Settings dialog 
when done 
 

Note that this is a Song specific setting – you will need to check this box for each Logic 
song as desired, and the setting will be saved with the Song file.
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Configure GearBox and TonePort to transmit Footswitch commands 
Launch the GearBox software and go to GearBox > Preferences … 
 
 

   

Select the MIDI/Control 
page 
 
 
 
 
 
 
Choose MIDI Machine 
Control as the Switch 
Function for the 
Footswitch jacks you are 
using 
 
 
 
Choose the Action you 
want each Footswitch to 
trigger in Logic  
 
Click OK to exit the 
Preferences dialog 

 
 
 
Done! 
Using the above configuration with two footswitches connected to TonePort, Footswitch 1 will 
alternately trigger Logic’s transport “Play” and “Stop” buttons. Footswitch 2 will toggle the transport 
“Record” button on/off, allowing you to trigger recording on all armed tracks. Additionally, 
Footswitch 2 will perform Punch In and Out “on-the-fly” if you press it while in Play mode.  
 
For more info on TonePort Footswitches, check the GearBox Online Help page. 
 
 
 
_________________________________________________________________________________ 
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DIGIDESIGN PRO TOOLS LE 6 SETUP – MAC® OS X 

Digidesign has designed Pro Tools software so it can only be used with a Digidesign or M-Audio audio 
interface; you cannot use TonePort as the primary audio interface for a Pro Tools system. But you can 
still enjoy the benefits of TonePort and GearBox by connecting TonePort to your Digidesign interface's 
inputs. TonePort UX2 even lets you do this with a direct, digital connection. 
 
For this document, we’ll be showing how to connect to the Digidesign Mbox unit, but these steps are 
similar for connecting to the Digi 002 or other Digidesign hardware as well. There are two methods 
described here – Recording from TonePort UX1 or UX2’s analog outputs, and recording from TonePort 
UX2’s digital S/PDIF output.  

 

Note that it is not necessary to have both your TonePort and Mbox units connected to the 
same computer. You can alternatively have your TonePort and Digidesign hardware on 
separate computers as well, since the two devices are indeed operating individually! 

Be sure to connect the USB cable from TonePort into your computer’s USB port, and then proceed with 
the following steps… 
       
 
 

Recording from TonePort UX1 or UX2’s Analog Outputs 

Connect the analog outputs from TonePort to the Digidesign Mbox 
 
 

 

(or UX2) device 
  

Using two ¼” to ¼” shielded TS or TRS 
audio cables, plug each into the Analog 
Outs of your TonePort UX1  
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Plug the other end of the left audio cable into the Mbox 
Source 1 input, and the right audio cable into the Mbox 
Source 2 input. 

From TonePort Right Analog Out 
  

 
From TonePort Left Analog Out 

 
 
 
 
 
 

You will still use the Mbox Line Outputs (or Headphone Output) to hear playback of all Pro 
Tools LE audio. The TonePort/GearBox audio will now be mixed with the Pro Tools LE audio 
as well. Therefore, if you are using headphones, you’ll want to plug them into the Mbox 
headphone jack to hear everything. 

 
 
 
Next, before you launch Pro Tools LE, launch the GearBox application, and open the GearBox 
Preferences dialog. 
 

 

Select the GearBox menu and choose Preferences 
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Choose the Hardware 
page 
 
Select your TonePort 
UX1 (or UX2) device… 
 
 
 
 
 
Then click the TonePort 
Driver Settings button 
 
 
 

 
 
 

 
 
 
 
 
 

1 1 4 Now launch the Pro Tools LE application and create a new

Choose your TonePort device in the Properties For selector, and then match the all the 
Audio Input and Audio Output settings shown here 
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Note that setting the System Output to your Built-in Audio device will result in your Mac system 
and alert sounds playing through this device. When using TonePort or Pro Tools, you likely will 
not want to hear these sounds at all. You can adjust the volume independently for these sounds by 
going to the Mac System Preferences > Hardware – Sound option > Sound Effects button… 

 

 
 
 Adjust the Alert volume slider down, and uncheck the Play user interface 

sound effects checkbox  
 
 

 

To start a new session in Pro Tools LE, 
choose New Session from the File menu 

 
 

      

Choose 44. 1 kHz or 48 kHz Choose 24 Bit 

Type in a name for your session and click Save 
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  Set up a new Pro Tools LE track for recording… 

 

 

Now that you have a new session, 
choose New Tracks from the File 
menu 
 

 
 
 

 
 
 
 
 
  

Choose how many Choose Mono or Stereo for 
your audio track format 
 

Click the Create 
button Tracks to create  

 

 
 

 

At the top left of the Edit Window, click the View 
selector and enable the I/O View 
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If the track you want to record into is Stereo, click on the track’s Input button and 
choose Interface > Mic/Line 1-2 (Stereo) 
 

Or… if the track you want to record into is Mono, click on the track’s Input button and 
choose Mic/Line 1 (Mono) to capture the TonePort LEFT signal, or choose Mic/Line 2 
(Mono) to capture the TonePort RIGHT signal 
 

Click the Arm button 
for the track to arm it 
for recording  
 
The track meters will 
now measure the 
TonePort/GearBox 
input signal level  
 

Click the Mute 
button to mute the 
track while 
recording* 
 

 
 
 
 
 

* Muting the track during recording disables the Pro Tools LE software monitoring feature, 
which allows your TonePort/GearBox analog input signal to be monitored with the lowest 
latency possible. Adjust the Mbox Mix knob to balance the session audio with the input audio 
(see your Mbox documentation for details).  

 
 
Note to Digi 002 users… when using the Digi 002 hardware with Pro Tools LE, an additional Low 
Latency Monitoring option is available within Pro Tools LE. You can alternatively keep your track 
un-muted and activate this option to hear your input monitoring signal when recording (see your Digi 
002/Pro Tools LE documentation for more on this feature). 
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If using the Digi 002, you can activate the 
Low Latency Monitoring in the Operations 
menu  
 

  
 

 

Set the Source 1 and 
Source 2 to “Line” 
input  

The Source 1 & 2 Gain 
knobs will now adjust 
the recording input 
level coming into the 
Mbox from 
TonePort/GearBox* 

 
 
 
 

 
 
 
 
 
 
 

Click the transport 
Record button to 
place Pro Tools LE 
into record mode, 
then press the Play 
button to start 
recording!  
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Recording from TonePort UX2’s S/PDIF Digital Output 

Connect the TonePort UX2 S/PDIF output to the Digidesign Mbox  
 

 
 
 
 
 
 

 

Using a 75-Ohm, coaxial S/PDIF cable, plug one end 
into the S/PDIF Digital Out of your TonePort UX2… 
 

Plug the other end of the S/PDIF cable into the  
Mbox S/PDIF In  
 

 
 
 
 
 
 
 

You will still use the Mbox Line Outputs (or Headphone Output) to hear playback of all Pro 
Tools LE audio. The TonePort/GearBox audio will now be mixed with the Pro Tools LE audio 
if you use the Pro Tools software monitoring function. See the later section regarding 
monitoring for more on this. 
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Next, you must launch the Pro Tools LE to set it to receive a S/PDIF input and digitally clock to your 
TonePort UX2 before launching the GearBox application. 
 
  

 

Go to the Pro Tools LE Setups menu and 
choose Hardware Setup 
 

 
 
 

Choose S/PDIF as the Ch. 1-2 Input Source  
 

 

Set the Clock Source 
to S/PDIF 

 
Click OK when done  
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Note that when receiving 
S/PDIF input, the Source 
1 & Source 2 Gain knobs 
do not adjust the digital 
signal level  
 

You will now see the 
S/PDIF indicator 
illuminated on the front of 
the Mbox 

To adjust the recording 
level, use the GearBox 
software’s output level 
controls 

   
 
 
Now you can launch the GearBox application and configure the TonePort UX2. 
 
 

 

Select the GearBox menu and choose 
Preferences 
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Choose the Hardware 
button 
 
Select your TonePort 
device… 
 
 
 
 
 
Then, click the TonePort 
Driver Settings button 
 
 
 

 
 

 
 
 
 
 

Choose your 
TonePort UX2 

Choose 44100 Hz for both the Audio Input and Audio 
Output Formats 

 
Next, return to Pro Tools LE and create a new Session… 
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Choose New Session from the Pro 
Tools LE File menu 

 
 
 
 Choose 24 Bit 
 Choose 44. 1 kHz or 48 kHz* 
 

      
 
 Type in a name for your session and click Save 
 
 
 
 
 
 
 
 
 

*If you prefer to use a 48 kHz Sample Rate, then you can choose it here in the Pro Tools 
dialog, but you will need to also go back to the Audio MIDI Setup dialog and set these values 
to match (see the previous step). Matching device sample rates is required with a digital 
connection. 
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Set up a new Pro Tools LE track for recording… 
 
 

 

Now that you have a new session, 
choose New Tracks from the File 
menu 
 

 
 
 

 
 
 
 
  

Choose how many 
Tracks to create  
 

Choose Mono or Stereo for 
your audio track format 
 

Click the Create 
button 

 
 
 
 

 

At the top left of the Edit Window, click the View 
selector and enable the I/O View 
 

 
      
 

 07-05-2006 Page 68



  
  GearBox 1.02 – Recording Setup Guide 

 
 
 
 

If the track you want to record into is Stereo, click on the track’s Input button and 
choose Interface > Mic/Line 1-2 (Stereo) 

 
 

  

 
 
 
 
 
 
 
 
 

Or… if the track you want to record into is Mono, click on the track’s Input button and 
choose Mic/Line 1 (Mono) to capture the TonePort LEFT signal, or choose Mic/Line 2 
(Mono) to capture the TonePort RIGHT signal 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Click the Arm button 
for the track to arm it 
for recording  
 
The track meters will 
now measure the 
TonePort/GearBox 
input signal level  
 

Keep the track’s Mute 
button set to un-muted to 
monitor your 
TonePort/Gearbox 
signal* 

* When receiving a S/PDIF input, the Mbox will only allow the signal to be monitored 
through the Pro Tools LE software. The track’s volume control will adjust the monitor signal 
coming from your TonePort/Gearbox, allowing you to balance your listening levels 
independently of your recording level. The Pro Tools LE software monitoring is also subject to 
latency, which is affected by your Pro Tools LE Hardware Buffer settings (see your Mbox 
documentation for more information regarding latency and monitoring). 
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Note to Digi 002 users… when using the Digi 002 hardware with Pro Tools LE, an additional Low 
Latency Monitoring option is available. It is best to activate this option when recording to hear your 
input monitoring signal with the lowest latency (see your Digi 002/Pro Tools LE documentation for 
more about this feature). 
 

 

If using a Digi 002 unit, you can activate 
the Low Latency Monitoring in the Pro 
Tools LE Operations menu  
 

 
 
Adjust the Pro Tools LE Hardware Buffers 
 
  

 

Return to the Pro tools LE Setups menu 
and choose Playback Engine 

 
 

 
 
 
 
 
 
 

 
 
 
Note – this Buffer Size value does not affect the monitoring latency when using the Digi 002 and 
the “Low Latency Monitoring” option. 

 

Set the H/W Buffer Size to 256 Samples. The lower the buffer size value that is selected, 
the lower the monitoring latency. However, lower values also result in less stability for 
session playback and recording. 256 Samples may be a good starting value to try. 
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Alternative monitoring option when using the Mbox… 
If monitoring your TonePort recording signal through the Pro Tools LE software results in 
excessive latency, you can alternatively connect TonePort’s Analog Outs to an external 
Mixing Console and manually mix the TonePort signal with the output of your Mbox. This 
allows you to hear the TonePort signal with no added latency from Pro Tools LE. In this 
configuration, you should Mute your Pro Tools LE track while recording to silence its 
software monitoring signal.  

 
Start recording… 
 

 
 
 

Now click the transport Record button to place Pro Tools LE into record mode, 
then press the Play button to start recording!  

 
 
 
 
 
 
_____________________________________________________________________________________ 
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MOTU DIGITAL PERFORMER 4.6 SETUP – MAC® OS X 

Be sure to connect the USB cable from TonePort into your computer’s USB port, and then proceed with 
the following steps… 

 

Configure GearBox and your Mac® to use TonePort as your audio device 

First launch the GearBox application and open the Preferences dialog. 
 
 

 

Select the GearBox menu and choose Preferences 

 
 
 

 

Choose the Hardware 
page 
 
Select your TonePort 
UX1 (or UX2) device… 
 
 
 
 
 
Then, click the TonePort 
Driver Settings button 
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Choose your TonePort device in the Properties For selector, and then match the all the 
Audio Input and Audio Output settings shown here 

 

Note that setting the System Settings Inputs & Outputs to your Built-in Audio device will result 
in your Mac system and alert sounds playing through this device. When using TonePort, you 
likely will not want to hear these sounds at all. You can adjust the volume independently for 
these sounds by going to the Mac System Preferences > Hardware – Sound option > Sound 
Effects button… 

 
 

 
 
 
 
 

Adjust the Alert volume slider down, and uncheck the Play user interface 
sound effects checkbox 
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Configuring Digital Performer 4.6 to use the TonePort driver 

Launch Digital Performer and make the following settings… 
 

 

First, go to the Digital Performer 
Setup > Audio System menu and 
select MOTU Audio System so that 
it is active 

 

Next, launch the Configure Hardware Driver dialog – you can 
access this from the Hardware button in the Audio panel  (or 
from the menu under Setup > Configure Audio System) 

 

Select 
CoreAudio 

Choose TonePort UX1 (or 
UX2), and then match all 
settings shown here.  
 
Choose 44100 as the 
Sample Rate - alternatively 
48000 or 96000 can also be 
used if your project requires 
it  
 
 
Click OK to exit 
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Back in the Audio panel, you will see the sample 
rate you already selected. Now choose Internal 
Clock and 24 Bit, if they are not already the 
current settings 

 
 

Preparing a Digital Performer Sequence for recording 

Now that the TonePort hardware is set up, you are ready to start working in a DP Project!  

 
Create a New DP Project (or open an existing one) and create a new audio track to record into for 
the Sequence. You can choose to add either a Mono or Stereo audio track to your current Sequence. 
This track type also determines which TonePort Record Sends you will have to choose from as inputs 
(Mono or Stereo).  
 

 
 
 

 
 

 

 

To create a Stereo track, go to the Project menu and choose Add Track > 
Stereo Audio Track  

First click on the Sequence button to 
display your tracks as we’re showing 
them here… 
 
 
 
We now need to set the track’s Output 
and Input to use TonePort. Click on 
the Output selector 
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Select New Stereo Bundle and 
choose your TonePort as the 
Output for this track 

 
 

Now click the Input selector for the track

 
 
 
 

Select New Stereo Bundle and you will see two TonePort stereo 
inputs to choose from. We’ll select Record Send 1-2 for this track. 

 
 
 

 
 
 
To configure a new Mono track, choose Mono Audio Track from the Project > Add Track menu. 
You can then follow the same steps as above for selecting TonePort as the Mono track’s Output and 
Input. Note that for a Mono track you will have slightly different options… 
 
 

 
Click on the Mono track’s Output selector 

 
 

Since we’ve already chosen the TonePort Main Out 1-2 Stereo output, it is selectable in 
the top portion of the menu. But alternatively, if you want to route the track output to 
only one TonePort output, you can choose New Mono Bundle and choose either Record 
Send 1 or 2. 
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Note that Digital Performer also allows for many other advanced routing options in the track 
output menu. Consult your Digital Performer documentation for more information.  

 

 
 Click on the Mono track’s Input selector 

 
 
 
 
 
 
Next, you can set your Monitoring options. When recording using GearBox, it is recommended to use 
the ToneDirect Monitoring feature, where your input monitoring signal is passed directly back out of 
TonePort’s output. This allows you to hear the GearBox tone you have selected for your Mic or 
Instrument with the lowest possible latency. Therefore, we will disable the Digital Performer Audio 
Patch Thru option so that the input monitor signal is not additionally fed through the software. 
 
 
 
 

 
 
 
To get an Input Level Meter for your armed track, launch the Audio Monitor panel. 
 
 
 
 
 
 

You will see 4 TonePort Mono Inputs to  
choose from for a Mono track.  

Set the Audio Patch Thru option to “off” 

Arm your configured audio track 
for Record  
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Select the Studio menu and 
choose Audio Monitor 

 
 
 
 

 
 

You will now see the 
Input Level coming from 
the selected TonePort 
Record Send for all 
armed tracks 

 
 
 

 

You can adjust your recording level in GearBox 
using the assigned Send’s Record knob  
 
 
 
 
 
 
Note that you can independently adjust your 
GearBox monitor level using the Monitor knob 
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Once your record level is set, just click on the Digital Performer transport Record 
button and start recording! 

 
 
 

 

 
 
 
 
 
 
___________________________________________________________________________ 
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PROPELLERHEAD REASON 3 SETUP – MAC® OS X 

Propellerhead Software’s Reason 3 is an amazing virtual studio filled with synthesizers, drums and effects, 
all combined with a MIDI sequencer for easy pattern-based music creation. Reason does not offer a 
feature for recording audio; therefore, GearBox and TonePort cannot be used for input directly into 
Reason. However, you do of course need a sound card device for playback, and TonePort is a perfect high 
quality interface for this task! When using TonePort, you can also simultaneously plug in your 
instruments and jam along with the playback of your Reason project, or utilize Reason’s ReWire 
technology to combine a Reason project with that of another ReWire capable audio software, and use 
TonePort as the audio device in this setup as well.   
 
Be sure to connect the USB cable from TonePort into your computer’s USB port, and then proceed with 
the following steps… 

 
 

Use TonePort as your playback device for Reason 3 

If you want to use TonePort as your sound card for Reason playback, then these steps show you how. 
Additionally, this also allows you to still plug in your instruments into TonePort and access all your 
GearBox tones if you want to jam along with your Reason project! 
 
 
Configure TonePort for Reason playback 
First launch the GearBox application, and then open the Preferences dialog. 
 
 
 

 

Go to the GearBox menu and choose 
Preferences 
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Select the Hardware 
page 

 
 
 

 

 
 
 

 
Choose your TonePort 
UX1 (or UX2) device 
 
 
 
 
Click the TonePort 
Driver Settings button 
  

Select the Audio devices page. Choose your TonePort device in the Properties For 
selector  

Match all settings as shown in the Audio MIDI Settings dialog above, and then close the 
dialog. Click OK to also exit the Preferences dialog. 
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Configuring Reason 3 to use the TonePort driver 

Launch Reason and make the following settings… 
 
 

 

Select the Reason 
menu and choose 
Preferences 
 

 
  

 
 

 

 
 

Select the Audio Page 
 
Choose TonePort UX1 (or UX2) 
as the Audio Card  
 
 
Choose a Sample Rate – 44100 is 
a good choice for most projects 
 
Close the Preferences when done  
 
 
 
 

You should now see your TonePort listed 
as the Audio Out device at the top left of 
Reason’s display 
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Now just hit the Play button in Reason’s 
transport and to hear the Reason 
playback through TonePort! 

 
 

To jam along with Reason… 

You can also of course still use GearBox for your Mic and Instrument tones while Reason is playing 
back if you want to sing or jam along. Just plug in your Mic or Instrument and use GearBox just as you 
normally do. Note that you can use the Send 1-2 Monitor knob to adjust the level of your Mic or 
Instrument independently of the level of the Reason playback. 

 
 

 

Use the Send 1-2 Monitor knob to adjust 
your Mic and Instrument volume level 

 
 
To control the playback level of Reason, use the Mixer controls in the Reason software. 
 

 

Use the Reason Mixer’s Master 
slider for overall control of 
Reason’s playback level.  

 
 
With this configuration, both the Reason project playback and your Mic/Instrument GearBox tones 
are heard through your speakers, and sent to all TonePort’s outputs. This also allows you to connect 
any of TonePort’s outputs to any external device, such as a tape recorder, mixer, P.A. system, etc. to 
record or amplify this stereo output signal! 
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Using TonePort with Reason 3 in a ReWire setup 

The Propellerhead “ReWire” technology allows the Reason modules’ outputs to be directly routed 
into any ReWire “Host” application. Using ReWire, the Host application can send MIDI tracks to 
Reason’s synth. modules, and Reason then sends audio playback directly into the ReWire Host, 
which is mixed with the audio of the Host application. When Reason is configured as a ReWire 
“Slave” in this manner, it is controlled by the Host application and does not utilize a sound card 
connection itself. Therefore, if you want to use TonePort as your sound card device in a ReWire setup 
like this, it is necessary for you to choose TonePort as the audio device for the ReWire Host 
application.  
 
 
Using Reason with Ableton Live Lite 4 as a ReWire Host 
The included Ableton Live Lite 4 software is capable of functioning as a ReWire Host application. 
The following steps show you how to set TonePort as the audio device for the Ableton Live Lite 4 
software, and then configure Live to connect with Reason as a ReWire Slave device. This allows you 
to do audio recording and playback with Ableton Live, allowing Reason’s output to be automatically 
played in sync and channeled through Live’s audio tracks via ReWire. 
 
You first want to be sure to exit Reason if it is currently running. The ReWire Host application must 
be launched first. Launch Ableton Live Lite 4 and make the following settings to set TonePort as the 
Live audio device… 
 
 

 

Select the Live menu and choose 
Preferences 
 

 
  

  
 

Select the Audio tab 
 
 
Choose CoreAudio as 
the Driver Type… 
 
Then choose your 
TonePort as both the 
Input and Output 
Audio Device 
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Now that Ableton Live Lite 4 is configured to use TonePort, launch Reason 3. Reason will 
automatically set itself to ReWire Slave Mode. You can check this mode in the Reason Hardware 
Interface module’s Audio Out section. 
 
 

 

Reason 3 detects when an available ReWire 
Master is running and sets itself to Slave mode 

 
 

Now in Ableton Live, you can simply access the Output menu of any MIDI track to set it to send its 
MIDI to any of the Reason synth modules. 
 

 

In any of Live’s MIDI tracks, choose Reason as 
the MIDI To output, and then click on the 
Output Channel selector to choose any Reason 
module 

 
 
 To receive the audio output from Reason, set the Input of any of Live’s audio tracks to receive the 
audio from any of Reason’s outputs. 
 

 

In any of Live’s Audio tracks, choose Reason as 
the Audio From input, and then click on the 
Input Channel selector to choose any Reason 
output channels 
 
(Note that the 1/2 Mix, Mix R channel receives 
the full Reason project audio mix) 
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Now just hit the Play button in either Live or 
Reason, and both projects will play in sync, with 
all the audio being routed into Ableton Live Lite 
4 and played through TonePort! 
 

 
You can utilize GearBox and TonePort to also plug in a Mic or Instrument, dial in your tone, and 
record audio tracks right into the Ableton Live Lite 4 Set. It is important to note, however, that 
running all these programs at one time can require some hefty usage of your computers processor, 
RAM and disk access, especially as you add more tracks, synth modules and real-time effects. Your 
actual performance will depend on the specifications of your computer.  
 
 
 
_________________________________________________________________________________ 
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STEINBERG CUBASE SE 1.0.7 SETUP – MAC® OS X 

Be sure to connect the USB cable from TonePort into your computer’s USB port, and then proceed with 
the following steps… 

 

Configure GearBox and your Mac® to use TonePort as your audio device 

First launch the GearBox application and open the Preferences dialog. 
 
 

 

Select the GearBox menu and choose Preferences 
 
  

 
 
 

 

Choose the Hardware 
page 
 
Select your TonePort 
UX1 (or UX2) device… 
 
 
 
 
 
 
Then click the TonePort 
Driver Settings button 
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1 1 3 Now launch the Pro Tools LE application and create a new

Choose your TonePort device in the Properties For selector, and then match the all the 
Audio Input and Audio Output settings shown here 

Note that setting the System Output to your Built-in Audio device will result in your Mac 
system and alert sounds playing through this device. When using TonePort, you likely will 
not want to hear these sounds at all. You can adjust the volume independently for these 
sounds by going to the Mac System Preferences > Hardware – Sound option > Sound 
Effects button… 

Adjust the Alert volume slider down, and uncheck the Play user interface 
sound effects checkbox 
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Configure Cubase SE to use the TonePort driver 

Launch Cubase SE and make the following settings…  
 

 

Go to the Cubase SE Devices 
menu and select Device Setup 

 
 Select the VST 

Multitrack option, and 
choose the Setup tab  

 

 
Choose your TonePort 
UX1 (or UX2) as the 
ASIO Driver 
 

 
 

 

Select Switch when prompted if 
you want to switch the ASIO 
driver… 
 
Click OK on the Device Setup 
dialog to exit 
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Next, select the Cubase 
SE Devices menu and 
choose VST Inputs 

    

 

Activate the power button for the 
TonePort inputs 3 and 4 if you want to 
record from TonePort Send 3-4. Cubase 
tracks will only allow recording from the 
inputs that are “active” here. 
  

 
 

Preparing a Cubase SE Project for recording 

Now that the TonePort hardware is set up, you are ready to start working in a Cubase SE Project!  
 

 

Check your Project’s Sample 
Rate and Bit Resolution – these 
are displayed at the bottom left 
of the Cubase Project window: 

 
44,100 Hz Sample Rate and 24 Bit are good recording settings for most Projects, but if you have 
specific requirements, these can be changed…  
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To change the Sample Rate or Bit 
Resolution, select the Project menu 
and choose Project Setup 

 

 

Choose different Sample 
Rate and Record Format in 
these pop-ups, if desired 

  
 
Click the OK button to exit 
the dialog 
 

 
    

Setting up an audio track to record from TonePort 

Cubase SE’s Audio track settings can be accessed easily in the Inspector pane at the left of the Project 
window. 

 
Stereo recording  
To record into the selected audio track from the TonePort Send 1 and  Send 2 as a stereo file, set the 
Inspector as follows: 
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Armed for recording  

 
Mono recording  
To record into the selected audio track from any TonePort Send as a  mono file, set the Inspector as 
follows: 
 

 
 

     
 

 
 
 
 
 
 
 

Input Monitoring OFF 
 
 
 
Stereo 
 
 
Playback out to BUS 1 
(TonePort) 

Mono 
 
 
Select any individual 
Send as the in 
recording source 

Now just click the 
Transport Record button 
and start recording!  

 
  
 
 
 
Input from IN 1+IN 2 
(TonePort Send 1 & 2) 
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Using TonePort UX2’s Footswitches to control Cubase SE 

You can connect up to two standard pedal footswitches into TonePort UX2 and configure them to 
remotely trigger most any function in Cubase SE 1.0.7. To follow is an example of how to set one 
Footswitch to toggle the Transport Play/Stop, and another to toggle Record on/off for hands-free punch 
in. Be sure to connect the USB cable from TonePort UX2 into your computer’s USB port, and then 
proceed with the following steps… 

 
 
Connect footswitch pedals  
 
TonePort UX2 offers two independent 1/4-inch jacks for connecting standard footswitch pedals.  
 

 

Connect two footswitch pedals into these 
Footswitches 1 & 2 jacks 
 

 
 
 
Configure the GearBox Footswitch settings 
 
First launch the GearBox application and open the Preferences dialog. 
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Select the GearBox menu and choose Preferences 
 
 
Choose  

 
 
 
 
 

Select the MIDI/Control page  
 

 

Select MIDI CC 
(On/Off) for both 
Switch 1 and 2 
 
 
Set both the Switch 
Modes to Single Pulse  
 
 
 
 
Click OK to exit when 
done  
 

 
 
 
 
 

For the Action setting, it really does not matter which CC value we choose, since 
we will simply be setting Cubase to receive whatever value is set here for each 
Footswitch. For this example, we will choose 000 for Action 1 and 001 for Action 2. 
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Configure Cubase SE to receive the Footswitch commands 
 
Switch to Cubase SE and launch its Device Setup dialog 
 

 

Go to the Cubase Devices menu and 
choose Device Setup 
  

 

 

Go to the Add/Remove tab  
 
 
Select Generic Remote  
 
 
 
 
 
 
 
Click the Add button 
  

 
 

 
 
 
 
 

Click on the Setup tab and choose your TonePort UX2 device as the MIDI Input. In 
the left Devices column you should now see the Generic Remote device we just 
created in the last step. Select it 
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Next, in the upper table of the Setup tab, we’re going to configure the first two Control items to 
receive the MIDI CC commands from the TonePort UX2 footswitches.  First you can double-click in 
the fields of these first two items in the Control Name column, and enter your own names – we’ll 
name them Play/Stop and Punch in. Match the rest of the settings in these top two rows as shown 
below: 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
   
 
 
In the lower table of the Setup tab, we’re going to configure the first two items to interpret the 
commands received to trigger the desired actions.  As soon as you click on one of the first two rows, 
you will see its Control Name update to be the same as what you entered in the top table. These 
correspond to the first two rows in the top table. Set the other fields as shown below: 

Set the MIDI Status  
to Controller 

The MIDI Channel can be 
any value, we’ll use 1 

Set the Address to 0 and 1 – these match the 
GearBox Action values we selected for the 
Footswitches 

Set the Max. Value to 127 – this is the 
MIDI CC Data Value 

Set the Flags to Received 
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Now your footswitches are configured! Try loading a project in Cubase SE and pressing your 
footswitches. Footswitch 1 should now toggle the transport Play and Stop buttons, and Footswitch 2 
should toggle the Transport Record button. You can of course use different settings in the lower table 
of the Cubase SE Device Setup > Setup tab window to assign the footswitches to any other desired 
Cubase functions. 
 
For more info on TonePort Footswitches, check the GearBox Online Help page. 
 
 
_________________________________________________________________________________ 
 
 

For Channel/Category 
choose Transport 

For the first item’s Value/Action choose 
Start/Stop For Device, choose 

Command 

The Flags settings will 
automatically set to P choose 
Transport 

For the second item’s Value/Action 
choose Record 

Be sure to click the OK button to exit the 
Device Setup dialog 
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STEINBERG CUBASE SX/SL 3 SETUP – MAC® OS X 

Be sure to connect the USB cable from TonePort into your computer’s USB port, and then proceed with 
the following steps… 

 
 

Configure GearBox and your Mac® to use TonePort as your audio device 

First launch the GearBox application and open the GearBox Preferences dialog. 
 
 

 

Select the GearBox menu and choose Preferences 

 
 
    

 

Choose the Hardware 
page 
 
Select your TonePort 
UX1 (or UX2) device… 
 
 
 
 
 
 
Then click the TonePort 
Driver Settings button 
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 1 1 2 Now launch the Pro Tools LE application and create a new
 

Choose your TonePort device in the Properties For selector, and then match the all the 
Audio Input and Audio Output settings shown here 

 
 Note that setting the System Output to your Built-in Audio device will result in your Mac 

system and alert sounds playing through this device. When using TonePort, you likely will 
not want to hear these sounds at all. You can adjust the volume independently for these 
sounds by going to the Mac System Preferences > Hardware – Sound option > Sound 
Effects button… 

 
 
 
 
 

 
 
 
 

 
 
 
 
 

Adjust the Alert volume slider down, and uncheck the Play user interface 
sound effects checkbox 
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Configuring Cubase SX/SL 3 to use the TonePort driver 

Launch Cubase and make the following settings… 
 
 

  

Go to the Cubase Devices menu and 
select Device Setup 

 
 
 

 
 

Select VST 
Audiobay 
within the 
Devices 
pane… 

 
 
 

 

 

Select Switch if you are 
prompted to select another 
driver… 
 

Then select ASIO TonePort UX1 (or UX2) as 
the Master ASIO Driver 

Then click OK to exit the 
Cubase Device Setup dialog 
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Configuring Cubase SX/SL 3 to use TonePort Inputs and Outputs 

Proceed with the following steps to establish TonePort’s Sends as Inputs for Cubase… 
 
 

 

Go to the Cubase Devices menu and choose VST 
Connections 

 
The following screen shows a useful configuration that you can match in your Cubase software. Once 
you set up Buses here, they will always be available for all your Cubase Projects… 
 

Choose the Inputs page  
 

 

Here you can create an 
input “Bus” for each 
possible Stereo and 
Mono Send 
combination coming 
from TonePort. The Bus 
Name can also be edited 
for each 
 
All Buses listed on this 
page will appear as 
Inputs within Cubase 
when choosing the 
recording input for an 
audio track 
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If no Buses yet exist in 
this list that use your 
TonePort audio device, 
then you must create at 
least one Bus… 
 
Click on the Add Bus 
button.  
 
Select Stereo or Mono.  
 
Click OK in the Add 
Input Bus window. 

 
 
 
 
   

Click on the Bus Name to edit it if desired 

 

 
 
 
 
 
 
 
 
 
Setting up an Output Bus is much the same process… 
 
 
 
 
 
 

For more information on creating and configuring Inputs, please check the Cubase SX/SL 3 
documentation 

Click on the 
individual Device Port 
entries for each Bus 
channel to set them to 
the preferred 
TonePort Send  
 
You can repeat these 
steps to create a Bus 
for each TonePort 
Send 
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Click the Outputs 
page 
 
If a Stereo Bus does 
not yet exist for 
your TonePort 
Audio Device, 
then use the Add 
Bus option to 
create a Stereo Bus, 
following the same 
steps listed above  Exit the VST Connections dialog when the Input and 

Output Buses are configured. 

Preparing a Cubase SX/SL 3 Project for recording 

Now that the TonePort hardware is set up, you are ready to start working in a Cubase Project!  
 
 

Check your Cubase Project’s Sample Rate 
and Bit Resolution – these are displayed at 
the bottom left of the Cubase Project 
window 

 
 
 

44,100 Hz Sample Rate and 24 Bit are good recording settings for most Projects, but if you have 
specific requirements, these can be changed…  
 
 

 

Select the Cubase Project 
menu and choose Project Setup 
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Setting up an audio track to record from TonePort 
 

 
 

 
 

 Choose different Sample 
Rate and Bit Resolution in 
these pop-ups, if desired 
 
Click the OK button to exit 
the dialog 

To create a new audio track, go to 
the Project menu and choose Add 
Track > Audio 

Choose Mono or Stereo for your 
desired recording track type 

 07-05-2006 Page 104



  
  GearBox 1.02 – Recording Setup Guide 

 
The Cubase Audio track settings can be accessed easily in the Inspector pane at the left of the Project 
window. Match the settings shown here… 
 
 

Armed for recording  

 

 

 
 

 
 
 
 

 
 

_____________________________________________________________________________________ 
 

 
Input Monitoring OFF* 

 
 
Record from your desired TonePort 
Input Bus 
 
Playback out to your TonePort 
Output Bus 

*Note that the track meters in Cubase will not measure the 
input signal unless the Input Monitoring feature is on. You 
can refer to the Send meters in the GearBox software as your 
signal level reference. 

Now just click the Transport Record button and start recording!  
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TONEPORT RECORDING SETUP – WINDOWS® 

This section is designed to provide general information for configuring TonePort and GearBox for use in 
different audio recording setups. Your TonePort device, since it connects to your Windows® computer 
via USB and includes WDM and ASIO audio drivers, is easily configured to work as your computer’s 
sound card. This means that you can access all your GearBox Tones directly from most any audio 
recording application, all at the highest quality! But you are of course not just limited to using TonePort 
to record into your computer – the outputs provided on the back of your TonePort additionally allow you 
to feed your GearBox signal to external tap machines, DAT recorders, PA systems, or whatever else will 
accept an analog line level signal. Additionally, TonePort UX2 includes a digital S/PDIF output to allow 
you to make these connections digitally!  

Using TonePort as your computer’s sound card device 

Once you have completed the GearBox software and TonePort driver installation, most everything 
you need for accessing TonePort from your audio recording/editing software is already done. A few 
helpful items for you to understand are input & output connections, audio drivers, and controlling 
your levels for recording. 

TonePort Connections 

When using TonePort UX1 or UX2 as a sound card for your audio application, to follow are the 
typical connections you’ll want to make… 

 

TonePort UX1 front panel connections 

 

 

 

 

Mic - To input a signal from a microphone, connect it here using and XLR cable. This inputs the 
microphone signal into GearBox where you can choose your Tone, and then route the processed 
signal both to your audio software and out the TonePort outputs. 
 
Guitar/Bass - To input your electric guitar or bass, plug it in here using a standard 1/4-inch TS 
instrument cable. This inputs the instrument’s signal into GearBox where you can then choose 

Connect our Guitar or Bass 

Connect your stereo 
Headphones Connect a Microphone 
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your tone and route the processed signal both to your audio software and out the TonePort 
outputs. 
 
Phones - If you want to listen to the audio from TonePort using stereo headphones, then plug 
them into this 1/4-inch stereo jack. This headphone jack outputs the same signal fed to the 
Analog Outs on the rear panel of TonePort; the audio from your audio software on the computer, 
as well as anything plugged into any TonePort input. 
 

TonePort UX1 rear panel connections 

 
 Connect any line level input 

source for monitoring to the 
Stereo Monitor In. 

Connect your USB cable from here 
to your computer’s USB port. *  

  
 
 
 
 
 
 

 
 

*Note – be sure to always power off or mute on your speakers or monitoring setup before 
connecting and disconnecting the USB cable between TonePort and your computer, as well as 
before booting up or shutting down your computer if TonePort is already connected. The best 
practice is to always power on your speakers last, and power them off first when connected to other 
audio gear to avoid a “pop”. 

 
Line Inputs - To record the signal from a line level source, such as a keyboard, your stereo 
receiver, the line out from a mixing console, etc., connect them to these Left and Right ins using 
1/4-inch TS audio cables. 
 
Monitor In - If you want to hear the signal from a line level source along with all the other audio 
coming from your computer, but do not want this audio recorded, then plug the source in here. 
Note that this is a stereo jack, so you should use a stereo 1/4-inch TRS audio cable for this 
connection.  
 
USB - This of course is where you connect the supplied USB cable to TonePort, with the other 
end going to your computer’s USB port. Note that you should always connect to a separate USB 
controller channel from other USB audio or MIDI interfaces to provide TonePort with the full 
USB bandwidth. TonePort also gets its power from this USB connection, so it should not be 

Connect the Analog Outs to 
your audio monitors.   

Connect any line level input 
source that you want to record 
into the Line Inputs.  
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plugged into a non-powered USB hub, or operated on the same USB controller channel with un-
powered devices. 
 
Analog Outs - These Left and Right unbalanced jacks output all the audio from TonePort; the 
audio from your audio software on the computer, and anything plugged into any TonePort input. 
So these are what you want to connect to your powered speakers or monitoring system for a 
recording setup. Use 1/4-inch TS cables to connect directly to powered speakers, mixer or power 
amp setup. Note that you can also use the headphone jack on the front of TonePort if you want 
to use headphones for monitoring. 

 

TonePort UX2 front panel connections 

 Connect your electric 
Guitar or Bass  

 
Connect up to two 
Microphones  

 Connect your 
stereo Headphones   

 
 
 

 
 

Microphone Inputs – You can receive input from one or two mics at the same time using these 
ins. There is also a +48V Phantom Power switch that you should toggle to “on” if your mic 
requires phantom power (most condenser type mics do, but check the documentation for your 
mic if you are not sure).  Connect each mic using an XLR cable. This inputs each microphone 
signal independently into GearBox where you can choose your tone, and then route the 
processed signal both to your audio software and out the TonePort outputs. 
 
Guitar/Bass – To input your electric guitar or bass, plug it into one of these inputs. Either of 
these routes the instrument’s signal into GearBox where you can choose your tone and route the 
processed signal both to your audio software and out the TonePort outputs. 
 

Norm – this input is for a standard instrument level output. Plug your guitar/bass into here 
using a standard 1/4-inch TS instrument cable. 
 
Pad – this input is designed for high output level basses and guitars, especially those with 
active pickups. Plug your high output instrument into here using a standard 1/4-inch TS 
instrument cable. 
 

Note - if you plug into BOTH the Norm and Pad inputs with two instruments at the same time, 
only the signal from the Norm input will be used. 
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Headphone - If you want to listen to the audio from TonePort using stereo headphones, then 
plug them into this 1/4-inch stereo jack. This Headphone jack outputs the same signal fed to the 
Analog Outs on the rear panel of TonePort; the audio from your audio software on the computer, 
as well as anything plugged into any TonePort input. 
 
 

TonePort UX2 rear panel connections 

 Connect your USB cable 
from your computer’s USB  

 
 
 
 
 
 
 
 
 
 
 
 
 

  
 

Note - if you plug into BOTH the Norm and Pad inputs with two instruments at the same time, 
only the signal from the Norm input will be used. 

 
Line Inputs - if you want to record the signal from a line level source, such as a keyboard, your 
stereo receiver, the line out from a mixing console, etc., connect them to these Left and Right 
ins using 1/4-inch TS audio cables. 
 
Footswitches - if you want to use one or two on/off toggle or momentary footswitches to 
remotely control functions in the GearBox software, you can plug the 1/4-inch footswitch plugs 
into these 1 and 2 jacks. To configure each Footswitch, go to the GearBox Preferences. You can 
also use these footswitches to trigger recording and playback commands within the included 
Ableton Live Lite 4 software! For more info on TonePort Footswitches, check the GearBox 
Online Help page. 

Connect the Analog Outs to 
your audio monitors.   

Connect any line level input 
source that you want to 
record into the Line Inputs. 
 

Connect up to two standard 
toggle or momentary pedal 
switches into the Footswitches 
jacks for remote control of 
GearBox and audio application 

Connect to the S/PDIF input of an 
external device to send TonePort’s 
output digitally. 

Connect any line level input 
source for monitoring to the 
Stereo Monitor In. 
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Note that when using a Dual-Tone configuration in the GearBox software, the footswitches will 
always control tone #1.  

 
USB - This of course is where you connect the supplied USB cable to TonePort, with the other 
end going to your computer’s USB port. Note that you should always connect to a separate USB 
controller channel from other USB audio or MIDI interfaces to provide TonePort with the full 
USB bandwidth. TonePort also gets its power from this USB connection, so it should not be 
plugged into a non-powered USB hub, or operated on the same USB controller channel with un-
powered devices. 
 
S/PDIF Digital Out -To send the output of TonePort to an external device digitally, connect a 
75-Ohm coaxial cable into this RCA jack and then into the S/PDIF digital input on the external 
device. This is the best choice for connecting to digital recording devices, such as a DAT 
recorder. This S/PDIF output sends the same audio as is sent to TonePort’s Analog Outs (with 
the exception that any audio coming into the TonePort’s Monitor In jack is not routed to the 
S/PDIF output). However, the S/PDIF signal is not affected by the GearBox Mute Line Outs 
button.   
 
Monitor In - If you want to hear the signal from a line level source mixed with all the other 
audio coming from your computer, but do not want this audio recorded, then plug the source in 
here. Note that this is a stereo jack, so you should use a stereo 1/4-inch TRS audio cable for this 
connection.  
 
Analog Outs - These Left and Right balanced jacks output all the audio from TonePort; the 
audio from your audio software on the computer, and anything plugged into any TonePort input. 
So, these are what you want to connect to your monitoring system when using TonePort as your 
computer’s sound card. Use either 1/4-inch TS or TRS cables to connect directly to your 
powered speakers, mixer or power amp setup. Note that you can also use the headphone jack on 
the front of TonePort if you want to use headphones for monitoring. 

 

Audio Drivers  

When a sound card device is installed on your computer, a “driver” is a software component that is 
installed which allows audio applications to communicate with the device, and send audio data back 
and forth for playback and recording. There are several different driver types in existence, and your 
TonePort uses the ones most commonly supported by the popular Windows® audio applications - 
ASIO and WDM.  
 

ASIO  

Short for Audio Stream Input Output, ASIO is a technology developed by Steinberg Media 
Technologies, GmbH. It offers the advantage of low latency operation, which means it allows 
audio to run through your audio software in very small chunks, minimizing the delay time 
between input and output. This all provides a much more immediate response with most aspects 
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of working in your audio software. TonePort’s ASIO driver also provides the advantage of 
exposing two stereo “Sends” (or 4 mono “Sends”) as inputs to ASIO software applications – 
more information on this is covered in the following Choosing TonePort Sends… section. 
Because of these advantages, it is recommended you use the TonePort ASIO driver if your audio 
software supports it.  

WDM   

Short for Windows® Driver Model, WDM is a Microsoft technology and widely supported by most 
all Windows® applications that do anything with audio. This WDM driver will allow audio 
applications to access TonePort via DirectX®, MME or WDM. The WDM driver is offered 
primarily as a general-purpose driver for multimedia applications that do not offer an ASIO 
driver (e.g. - Windows Media Player®, WinAmp®, etc.).  When using the WDM driver, 
playback and recording features are more limited: 

• Latency performance is typically not as fast as ASIO 

• Only one stereo Record Send (Send 1-2) will be available from GearBox to the 
recording software. 

• Supported sample rates for recording and playback are dictated by the audio software 
when in WDM mode and, therefore, may change the list of available sample rates when 
using TonePort. 44.1KHz and 48KHz are most typically supported. 

 

Accessing TonePort as a sound card device 

Exactly how you access TonePort as your sound card from within audio software differs somewhat for 
each audio software. Typically you’ll find a “Preferences” or “Audio Setup” dialog that allows 
choosing your driver type and device for both output (playback) and input (recording). For example, 
these settings can be accessed in the Preferences dialog in the Ableton Live Lite 4 application… 

 

 
Ableton Live’s Preferences > Audio Device settings - ASIO 

Using TonePort’s WDM Driver 

As mentioned in the previous Audio Drivers section, if you want to use TonePort with a 
multimedia application that does not support ASIO, then you can choose TonePort’s WDM 
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driver from within the application. Exactly how this appears within the multimedia application 
may differ – typically, you can choose any variation for the TonePort driver that denotes the 
“TonePort” device name along with “DirectX® (or “DX”), “Wave” (or “MME”) or “WDM”.  
 
As an example, this appears in the Ableton Live Lite 4 software’s Preferences window as 
follows… 

 

   

First choose MME/DirectX 
as the Driver Type 
 
 
 Then choose the TonePort 
DX or Wave audio device for 
Input and Output 
 

Ableton Live’s Preferences > Audio Device settings – WDM/DirectX 

 

Choosing TonePort Inputs and Outputs in your audio software 

Often, all that is required is to choose TonePort as your audio device as shown above, and the 
audio software then automatically routes all its playback and recording settings to work with 
TonePort. If the audio software supports Multitrack audio recording, then it likely also allows 
you to choose specifically which input and output port to use for each audio track.  
 

Choosing TonePort Sends as recording inputs within your audio 
software 

The GearBox software allows you to route your tones to “Sends”. Your audio software can access 
these Sends as inputs for recording. Within the GearBox software, you can determine what 
actually gets routed to each of these sends. This all provides you with a great deal of flexibility for 
Multitrack recording in your audio software!  
 
As mentioned in the previous section, if you are using the ASIO driver for TonePort, then the 
audio software will be able to access both “Send 1-2” and “Send 3-4”, and choose between them 
as inputs for each audio track recording. Further, the audio software will usually also be able to 
choose each individual mono Send (Send 1, 2, 3 and 4) to record a mono track. Looking once 
again at an example in Ableton Live Lite 4, each audio track allows you to choose its input 
source – each selectable input directly refers to the TonePort Sends… 
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An audio input selector for a track in Ableton Live. 
 
TonePort’s Sends appear as two stereo pair options and 
4 mono options. 

Choosing TonePort for playback within your audio software 

For most audio software projects, you’ll likely want all tracks, input monitoring signals and buses 
to go out to one common stereo output, so you can hear your entire mix on your stereo speakers. 
Usually just setting TonePort as your output audio device is all you need to do to make this 
happen, but in some audio software, you may need to check the outputs of your individual tracks 
as well. Similar to the above instructions, just go to the track’s output selector and choose the 
TonePort device as your output. TonePort will be available as a stereo output for playback of 
each track.  
 

Choosing TonePort as your Windows® default sound playback 
device 

Windows® itself also makes use of a sound card device to be able to play all those dings, beeps 
and other system alerts. The Windows® default sound playback device is also what gets used for 
the Windows® Media Player® application, which can play your CD’s, DVD’s and multimedia 
downloads from the Internet. Additionally, many other multimedia programs such as 
WinAmp®, RealPlayer®, etc., will automatically set themselves to use the Windows® default 
device as well. TonePort can be set to be this default device if you want to utilize its high quality 
audio for playing your CD’s or DVD’s, for example. 
 

Setting the Windows® default sound playback device 

Click on your Start button and go to Settings > Control Panel > Sounds and Audio Devices > 
Audio tab. In the Sound playback section, choose your TonePort as the Default device. Click OK to 
exit the dialog. 
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TonePort set as the 
Windows Default device 
for playback 

 

Considerations when setting TonePort as the Windows® default device: 

 

Surround playback - TonePort’s playback capability is designed for stereo. If you already have a 
sound card that provides surround sound via multiple speakers, this would also be a feature that you 
would lose by making TonePort your preferred audio device. 
 
On-board synth sounds - Some sound cards also have synthesizer chips onboard that will receive 
MIDI content and play audio directly out of the card. These sounds might also not be available to you 
if using TonePort as the Windows® default device, since your speakers will be connected to 
TonePort. If your sound card has one of these synthesizer chips, one solution is to connect the audio 
output from your other sound card to the Monitor In jack on the back of your TonePort. 
 
Windows® System Alert sounds - It can actually be quite annoying to have all those Windows® 
system alert sounds blaring at high volume through your TonePort when you are trying to focus on 
more musical endeavors. Fortunately you can independently turn off these system sounds and still 
keep TonePort as your Windows® default playback device. Click on your Start button and go to 
Settings > Control Panel > Sounds and Audio Devices > Sounds tab. For the Sounds Scheme 
setting, choose No Sounds. Click OK to exit the dialog. 
Accelerated 3D audio – Computer games may also set themselves to use the Windows® default 
device, and some can have multichannel or specific accelerated 3D audio playback requirements. 
TonePort does not support this and may not perform properly with these types of applications.  
 
Audio CD playback - Some computers have the audio output of their CD drive physically wired to 
an internal sound card. If your computer is setup this way, TonePort as the preferred audio device may 
still not be the sound card that plays the CD audio. You can usually enable a “digital CD audio” 
option for most CD drives which will then allow it to send the CD playback digitally to TonePort.  
 
To access this setting, go to your Windows® Desktop and right click on My Computer, choose 
Preferences, go to the Hardware tab, and click the Device Manager button. Click on the + symbol 
at the left of the CD Drive line to expand it. Now double click on your CD drive and go to the 
Properties tab. Check the box for Enable digital CD audio for this CD-ROM device. 
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If your CD drive doesn't support digital playback, then this option will not be selectable. If this is the 
case, another solution is to connect the stereo Line Out from your computer’s sound card to the 
Monitor In jack on the back of your TonePort. 
 
 
The Windows® Mixer - The Windows® Mixer utility also defaults to controlling the Windows® 
default device. This is not necessarily a problem, but it is important to be aware of the fact that this 
means all the controls in the Windows® Mixer’s Wave and main Volume sections (Pan, vertical 
Level slider and Mute checkbox) will affect TonePort’s monitor output. Likewise, the Windows® 
Mixer also controls the default device’s Recording Pan/Level/Mute settings as well. You may want to 
just keep all these Windows® Mixer settings at “unity” settings so that they do not affect TonePort’s 
monitor signal – that is, keep the Pan set to center, the Level sliders to all the way up, and the Mute 
checkboxes off. Then you can just use the GearBox software to control these Monitor functions.  
 

Note - if you have one of the fancier computer keyboards or a laptop that include volume and 
mute buttons, then these will adjust these same Windows® Mixer controls. 

 

 

The Windows® 
Mixer Volume and 
Wave controls affect 
the Windows® 
default device’s 
playback output 
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To access the Windows® Mixer Recording controls, go to the Options menu > Properties and 
choose the Recording option… 
 

 

 

 
 
 

TonePort Control Console 

The TonePort Control Console dialog within the GearBox software includes several options and 
indicators pertaining to using your TonePort along with other audio applications. To access the 
dialog, first be sure your TonePort is connected to your computer’s USB port and then launch the 
GearBox application. Go to the Edit menu and select Preferences, and go to the Hardware tab. Click 
the TonePort UX1/UX2 Driver Settings to launch the TonePort Control Console dialog… 
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5 
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Most of the default settings are typically fine for using TonePort/GearBox with another audio 
application. To follow is general information about how the settings and indicators in this dialog 
relate to the operation with other audio programs: 
 

1. Detected hardware selector – Your connected TonePort device should appear here. If not 
then it may not be properly connected to your USB port. 
 
2. Driver information - The text in this section dynamically updates informing you the status of 
the TonePort driver. When no other audio application is utilizing TonePort, it reports No ASIO 
client is active – this is the normal status when using TonePort/GearBox on its own. When an 
audio application is utilizing the TonePort driver, the text will report the application by name 
(e.g. – Live 4.1.4.exe client is active). The driver’s operating sample and bit rate are also 
displayed here. 
 
3. Force TonePort/GearBox format - When checked, this allows you to manually set the 
TonePort driver sample and bit rate. Usually it is best to leave this unchecked and allow the 
audio application to set the driver to match its own session format.  
 
4. ToneDirect Monitoring buffer - The recommended setup is to allow your mic and instrument 
input that go into TonePort be monitored directly out of TonePort (ToneDirect Monitoring), as 
opposed to using a connected audio software’s monitoring feature. ToneDirect Monitoring 
provides the lowest possible monitoring latency since your input only needs to run through 
TonePort and the GearBox software, rather than also through the entire signal path of the audio 
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application. The lower you set this buffer, the shorter the latency for ToneDirect Monitoring, 
but a higher value setting offers better stability and may resolve audio dropouts.  
 
5. Interface to ASIO - these are the ASIO driver buffer setting and Bit resolution. A lower 
buffer allows you to achieve lower latency in the connected audio software, but uses more CPU. 
512 is a good setting for most uses. 16 and 24 bit are supported by most applications, however, 32 
bit is the highest quality setting and you should use it if your audio software supports it. 
 
6. ASIO Sample Rate Converter indicator - When an audio application is requesting a different 
sample rate than TonePort is able to operate at, TonePort will auto convert the sample rate, and 
this light will be on to inform you this process is active. It is best to avoid this process and match 
the sample rates wherever possible, either by switching the audio applications sample rate, or by 
using the Force format checkbox in the Control Console. 
 

Note that TonePort natively supports both 44,100 Hz and 48,000 Hz sample rates. It is also 
compatible with the 96,000 Hz sample rate, which means that ASIO audio software can be set to 
operate at this rate and TonePort will use this ASIO Sample Rate Converter to allow playback 
and recording. 

 

GearBox settings and recording 

Once you are set up for recording with TonePort, then you probably will want to think about what to 
record! GearBox is all about Tones, and this is where you go to set up your mic, guitar or bass tones 
that will be recorded into your audio software. To follow are basic guidelines for choosing GearBox 
settings.  
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Choosing your GearBox source 

Once you have your mic, instrument or line level item(s) plugged into TonePort, click on the 
Source Select to choose which of these “sources” you want to create a Tone for.  

TonePort UX1 Source Menu  

Options within this menu provide the ability to create a tone for the Mic, Analog and 
Guitar/Bass inputs separately, or a “Stereo” or “Dual-Tone” source.  
 

 

TonePort UX1 Source Select menu  
 
Stereo sources include “Stereo” in the name, 
and Dual-Tone sources include the “&” 
symbol in their names  

 

Tone Port UX2 Source Menu 

TonePort UX2 additionally offers Source options that include its Mic 2 input. 

   

TonePort UX2 Source Select menu  
 
Stereo sources include “Stereo” in their name, 
and Dual-Tone sources include the “&” 
symbol in their names 

 

Choosing Tones in GearBox 

Since there are different types of Input Sources, to follow are a few guidelines for setting up your tones 
for these types of Sources. 

Single Input Source   

When a single Input Source is selected, the GearBox displays the last tone preset that was in use 
for this Source. You can of course choose any preset from the Tone menu, or customize the tone 
by selecting your desired amp, preamp and effects models.  
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Stereo Input Source 

A Stereo source accepts the inputs from the selected “Stereo” TonePort ins and processes them 
as one Stereo signal. This means that you still choose and edit one tone setting, just as you do for 
a single source, but the tone is applied to both channels, providing a stereo output.    

Dual-Tone Input Source 

If you select one of the Dual-Tone sources, then you are able to choose a tone independently for 
each. For example, if you want to record a performance using an instrument and a mic that are 
plugged into TonePort’s Guitar/Bass and Mic inputs, you likely want to use separate Guitar Amp 
and Mic Preamp tones. To edit the separate tone settings, use two buttons that appear at the left 
of the Tones menu – both tones remain audible regardless which tone is displayed: 
 
 
 

 

Two “Tone” buttons appear when a 
Dual-Tone Input Source is in use.  

 

Setting up GearBox Sends 

GearBox offers two sets of stereo Record Sends which each offer independent Pan, Record and 
Monitor levels. You can think of these Sends as “virtual” outputs that are internally routed to both 
your recording software, and to the TonePort hardware outs. Your GearBox tones are automatically 
routed to these Sends and you use these Send controls to configure the stereo placement, recording 
level sent to your audio software, and monitoring level respectively. Setting these levels is the same 
for either Send 1-2, or Send 3-4. 

 

 

The Pan knob and 
Mono switch 

The Monitor level 
knob and Mute switch 

The Record level knob and 
Boost switch  

Pan 

The Pan knob adjusts the left/right balance of the Send signal sent to the recording software. If 
you want the Input Source tone to be summed as a Mono signal, with this Mono signal then 
being routed out both channels of the Send, you can activate the Mono switch.  
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Record level 

The Record knob adjusts the level of the signal sent to your recording software, and directly 
affects the amplitude of your recorded audio. Additionally, the Boost switch can be activated if 
the signal needs an additional 18 dB of gain. The rule for recording levels and digital audio is to 
always avoid clipping, yet keep the level at least above half to capture a nice strong signal. Use 
these controls and reference the meters above to adjust this level accordingly. Your audio 
software likely has meters that will reflect this level as well. 

Monitor level 

The Monitor knob adjusts the level of the ToneDirect Monitoring signal fed out of TonePort’s 
outs. You can activate the Mute switch to mute the ToneDirect monitoring signal completely. 
These controls do not affect the Record level that is sent to your recording software. This allows 
you to balance the listening volume of your GearBox tone signal and the playback of tracks 
coming from your recording software.  
 

Note that the Output knob on your TonePort hardware will adjust the levels of your Tone Direct 
Monitoring and recording software playback for control of the overall volume of what is heard on 
your speakers. 

Recording Send 3-4 

Send 3-4 is displayed by selecting the button in the row above the effects panel display.  
 

 

Click on Send 3-4 to 
display the Record Send 3-
4 controls in the edit panel 

 

Send 3-4 appears as an additional set of inputs to ASIO compatible audio recording software only. 
If the recording software is using the WDM TonePort driver, then it these 3-4 audio channels will 
not appear as inputs in the application. 

 
Send 3-4 is especially useful when you are using a Dual-Tone Input Source in GearBox, since 
you can then set each tone to a separate Record Send. This then allows your recording software 
to access these two tones as separate, discrete signals and record them on separate tracks within 
the same recording take.  
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Sending audio from TonePort to an external device 

Rather than accessing the GearBox Recording Sends’ signal from TonePort as a sound card device, 
you may instead want to route your GearBox signal out to another sound card on the same or separate 
computer. Further, with all the great tones you can now create for your mics & instruments with 
GearBox, there is no need to limit them to the inside of a computer!  You may also want to send the 
signal to external hardware such as an analog or tape Multitrack unit, a DAT or video tape recorder, 
or even to an amplifier or P.A. system for live performance.  To follow are instructions for these 
different types of setups. 

Connecting analog outputs from TonePort/GearBox to an 
external device  

You can route your tones from TonePort/GearBox to just about any type of external device 
simply by connecting the Analog Outs from the back of your TonePort UX1 or UX2 directly 
into the external device’s line level inputs. This allows you to amplify or record your GearBox 
signal using any external device that accepts analog line level inputs.  
 
 

 

Connect TonePort’s Analog Outs to any the 
analog inputs on any external audio device 

Routing TonePort’s analog outputs to another sound card 

If you want to use TonePort/GearBox in a computer recording setup where a multi-input sound 
card already exists, then you might find it useful to connect TonePort’s Analog Outs into two of 
the analog inputs of the existing sound card. This allows you to use the existing sound card with 
your recording application to also receive additional discrete inputs directly from other sources at 
the same time, if this is the preferred setup. When TonePort is connected to another sound card 
this way, then you will want to be sure your recording software is set to use the other sound card 
as its input device for recording. In this configuration, since TonePort is not acting as a sound 
card device, the TonePort’s  Analog Out signal is what is being recorded, and therefore, levels 
are controlled by the GearBox Monitor level and TonePort Output knob.  
 

Connecting the S/PDIF Digital Output from TonePort 
UX2/GearBox to an external digital device  

TonePort UX2 also includes an S/PDIF digital output, which allows you to connect to digital 
devices such as a DAT recorder, MiniDisc, another sound card, or most any device that offers an 
S/PDIF format digital input. This is the preferred method to connect to external devices since it 
does not require the added digital-to-analog-to-digital signal conversion process as required with 
using analog outs.  
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Digital clock settings 

When connecting digital devices in this manner, one device needs to sync to the “digital clock” 
of the other, and preferably both should also operate at the same sample rate. To configure this 
correctly, you’ll need to look for a “clock” setting on the digital device you are connecting to and 
set it to “External” or “S/PDIF” so that it follows the digital clock of your TonePort rather than 
its own internal clock. If you are connecting to the S/PDIF input of another sound card, this can 
be either a hardware switch on the unit, or an option found in the software control panel for the 
device. As an example, when connecting TonePort UX2 digitally to a Digidesign Mbox for 
recording in Pro Tools LE, you access the Mbox clock settings within the Pro Tools Hardware 
Setup dialog:  
 

 

Setting the Digidesign Mbox to 
“follow” the TonePort S/PDIF 
clock and receive S/PDIF 
digital input for recording  

 

Sample rate 

Since TonePort UX2 is acting as the “master” clock device in this scenario, you should also 
manually set the desired sample rate for TonePort, so that the external digital device will follow 
the sample rate you desire. This is done in the TonePort Control Console, using the Force 
TonePort/GearBox format option. You will want to check the box to enable this function, and 
then choose 44.1 kHz or 48 kHz.  
 

The TonePort Control 
Console’s options for 
manually setting the sample 
and bit rate   

 
 

Setting output levels for the S/PDIF output 

The S/PDIF output of TonePort UX2 receives the same audio content as is heard at the Analog 
Out and Headphone out, with the exception that the any audio coming in from TonePort’s 
Monitor In jack is not routed to the S/PDIF output. When devices are connected digitally, 
typically the receiving device does not include a level control to adjust the level at input. 
Therefore, you’ll want to set the level as from the GearBox software if necessary. The GearBox 
Monitor knob controls the level going out of S/PDIF output. (Note that the Mute switch above 
the Monitor knob does not mute the S/PDIF output). You’ll want to keep this Monitor level as 
high as possible, without clipping, for the best fidelity when using the S/PDIF Digital Out.  
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Other considerations for using S/PDIF output 

• TonePort UX2 always outputs its S/PDIF signal at 24-bit resolution. The signal is never 
truncated or dithered to a lower bit depth. Therefore, if the device you are connecting 
to offers a bit resolution setting, it is best to set it at 24-bit (or higher) to capture the full 
S/PDIF signal resolution. 

• Some digital devices may only support one sample rate (some DAT and video machines 
are fixed at 48 kHz for example), so you will want to be sure to choose a sample rate 
supported by both units. 

• When TonePort UX2 is operating in its 96 kHz “compatible” sample rate mode, it sends 
data out the S/PDIF at 48 kHz.  

• The Mute Line Outs button that is found at the bottom left of the GearBox window 
(beneath the Out to Hardware label) will mute all analog outputs when active, but will 
not mute the S/PDIF signal.  

• Remember that if you are connecting TonePort UX2’s S/PDIF output to another sound 
card, you are not limited to the other sound card being on the same computer. You can 
use TonePort/GearBox as for your tone and then send it digitally to a completely 
different setup for recording! 

 
 
 
 
_______________________________________________________________________ 
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ABLETON LIVE LITE 4, LINE 6 EDITION SETUP - WINDOWS® 

Be sure to connect the USB cable from TonePort into your computer’s USB port, and then proceed with 
the following steps… 
 

Configure your PC to use TonePort as your audio device 

First launch the GearBox application, and then go to the Help menu to launch the TonePort Control 
Console. 

 

 

Select the GearBox Help menu 
 
Choose Hardware & Driver Settings 

 
  

 

Select your 
TonePort UX1  
(or UX2) device 

 

Configuring Ableton Live Lite 4 to use the ASIO TonePort driver 

Launch Ableton Live Lite 4 and make the following settings… 
 

 
 
 
 
 
 
 
 
 
 
Select 32 bit 
 
 
Click Apply when 
done  
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Select the Live Options 
menu and choose 
Preferences 
 

 

  

Select the Audio tab 
 
 
 
 
Choose ASIO as the 
Driver Type * 

 
 
  
  

 
 

* It is highly recommended to use the ASIO Driver Type for TonePort for the best 
performance. If you want to use the MME/DirectX Driver Type, please refer to the 
Mme/DirectX Driver section. 

 

Select  
ASIO TonePort UX1 
(or UX2) as the Audio 
Device 
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Choose a Sample Rate - 
44100 is a good setting for 
most projects 
 
Next, click the Input 
Config button to set up 
inputs  

 
 
 

 

Click on the 3 & 4 
(mono) and the 3/4 
(stereo) Input buttons to 
activate them if you will 
want to record from 
TonePort Sends 3 and 4 
into Live. 

Click on the OK button 
to return to the 
Preferences dialog 
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Select the Misc tab 

Select 24 as the Bit 
Depth 

  
 

Click on the X 
button to exit the 
Preferences dialog 

  
 

 
This completes the Audio Driver configuration! 
 
 
 

Setting up an audio track to record from TonePort in Ableton Live 

Now that your TonePort hardware is set up, you are ready to start working in a new Live Set! Open or 
create a new Live Set and make the following settings… 
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Click the Session View 
Selector to switch to 
the Session View  

 
 
 
 

 

The In/Out  
settings group 

Click the Show/Hide 
In/Out Selector to 
display this group of 
settings in the Mixer 
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Click the Monitor Off 
button for the Audio 
Track you wish to record 
into 

 

 

Select Ext. In 
as the Audio 
From setting 

 

 

Select the Input Channel: 
-1/2 will record from TonePort Sends 1 & 2 as a Stereo file. 
-3/4 will record from TonePort Sends 3 & 4 as a Stereo file. 
-1, 2, 3 or 4 will record from the respective TonePort Send as a 
Mono file. 

 

   

Click on the Arm switch to 
arm the track for recording 
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Click the Arrangement View 
selector to switch to the 
Arrangement View display  

 
 
 

Click the Global Record 
Button to prepare the Live Set 
for recording  

 
 
 
 Click the Play Button 
to start recording!  

 
 
 

 

Using the MME/DirectX Driver Type  

As mentioned on page 2, it is recommended to select the ASIO driver type with TonePort since it 
provides lower latency performance and the ability to access an additional set of stereo Record Sends 
within your audio applications. The MME/DirectX driver type can be selected in Ableton Live as an 
alternative.  
 
Go to the GearBox Help menu and select Hardware and Driver Settings to launch the Control 
Console: 
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Select your TonePort UX1  
(or UX2) device 
   
 
 
 
 
 
 
 
 
Select 32 bit 
 
 
 
Click Apply 
 

 

 
Once the above settings are made in the Control Console, go to the Ableton Live Preferences dialog 
and set it to use the MME/DirectX driver. 
 

 

First choose MME/DirectX as 
the Driver Type 

 
 

 
 Then choose the TonePort 
DX or Wave audio device for 
Input and 
 Output 
 

 

 
 

Using this MME/DirectX driver type, Ableton Live will only be able to access Record Send 1-2 from 
TonePort, since Record Send 3-4 is only available when using the ASIO TonePort driver.  
 
 

For more information, try the Lesson within the Help menu of Ableton Live Lite 4 for 

Recording with Live and TonePort… 
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__________________________________________________________________________________ 
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ABLETON LIVE 5 SETUP – WINDOWS® 

Be sure to connect the USB cable from TonePort into your computer’s USB port, and then proceed with 
the following steps… 

 

Configure your PC to use TonePort as your audio device 

First launch the GearBox application, and then go to the Help menu to launch the TonePort Control 
Console. 
 

Select the GearBox Help menu 

 

 
Choose Hardware & Driver Settings 

 
 
Match all settings in the TonePort Control Console dialog, as shown here…  
 

 

Select your TonePort 
UX1 (or UX2) device 

 
 

Configuring Ableton Live 5 to use the ASIO TonePort driver 

Launch Ableton Live 5 and make the following settings… 
 

 
 
 
 
 
 
 
 
 
Select 32 bit 
 
 
Click Apply when done  
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Select the Live Options 
menu and choose 
Preferences 
 

 
  

 
 
 
 
 

 

 
 

 
 

Select the Audio tab 
 
 
 
 
Select ASIO as the 
Driver Type * 

Select the preferred Sample 
Rate - 44,100 is a good choice 
for most projects 

Select  
ASIO TonePort UX1 (or UX2) 
as the Audio Device 

* It is highly recommended to use the ASIO Driver Type for TonePort for the best 
performance. If you want to use the MME/DirectX Driver Type, please refer to page 7 of this 
document for additional settings that must be made first. 
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Click the Input Config 
button to set Inputs 

 
 
 

 

Click on the 3 & 4 (mono) 
and the 3/4 (stereo) Input 
buttons to activate them if 
you will want to record from 
TonePort Sends 3 and 4 into 
Live. 

Click on the OK button 
to return to the 
Preferences dialog 

 
 
 
 
 

 

Select the Defaults tab 

Select 24 as the Bit Depth
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Click the X button to exit 
the Preferences dialog  

 
 
This completes the Audio Driver configuration! 
 
 
 

Setting up an audio track to record from TonePort in Ableton Live 

Now that your TonePort hardware is set up, you are ready to start working in a new Live Set! Open or 
create a new Live Set and make the following settings… 
 

 

Click the Session View Selector to 
switch to the Session View  

 
 

 

The In/Out settings group 
displayed 

Click the Show/Hide In/Out 
Selector to display this group of 
settings in the Mixer 
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Click the Monitor Off 
button for the Audio Track 
you wish to record into 

 

 

Select Ext. In as the 
Audio From setting 

 

 

Select the Input Channel: 
-1/2 will record from TonePort Sends 1 & 2 as a Stereo file 
-3/4 will record from TonePort Sends 3 & 4 as a Stereo file 
-1, 2, 3 or 4 will record from the respective TonePort Send as a 
Mono file 

 

  

Click on the Arm switch to arm 
the track for recording 
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Click the Arrangement View 
selector to switch to the 
Arrangement View display  

     
 
 

Click the Global Record 
Button to prepare the Live Set 
for recording  

 

 
 
 
 
 

 

Click the Play Button 
to start recording!  

 
 

 

Using the MME/DirectX Driver Type  

As mentioned on page 2, it is recommended to select the ASIO driver type with TonePort since it 
provides lower latency performance and the ability to access an additional set of stereo Record Sends 
in your audio applications. The MME/DirectX driver type can be selected in Ableton Live as an 
alternative.  
 
Go to the GearBox Help menu and select Hardware and Driver Settings to launch the Control 
Console: 
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Select your TonePort UX1  
(or UX2) device 
   
 
 
 
 
 
 
 
 
Select 32 bit 
 
 
 
Click Apply 
 
 

 
 
Once the above settings are made in the Control Console, you can go to the Ableton Live 
Preferences dialog and set it to use the MME/DirectX driver. 
 

   

First choose MME/DirectX as 
the Driver Type 
 
 
 Then choose the TonePort 
DX or Wave audio device for 
Input and Output 
 
 

  
 
 
Using this MME/DirectX driver type, Ableton Live will only be able to access Record Send 1-2 from 
TonePort, since Record Send 3-4 is only available when using the ASIO TonePort driver. 
 
 
 
__________________________________________________________________________________ 
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CAKEWALK SONAR HOME STUDIO VER. 4 SETUP – WINDOWS® 

Be sure to connect the USB cable from TonePort into your computer’s USB port, and then proceed with 
the following steps… 

 

Configuring TonePort’s Control Console 

First launch the GearBox application, and go to the Help menu to launch the TonePort Control 
Console. 
 

 

Select the GearBox Help menu 
 
Choose Hardware & Driver Settings 

 
 
 
Match the settings in the Control Console dialog as shown here… 
 

 

Select your 
TonePort UX1  
(or UX2) device 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
Select 24 bit* 
 
 
Click Apply when 
done  

* Note – it is best to set this TonePort Bit Rate option before launching Sonar. If you 
change this with Sonar already running, it may cause playback to stop working until you exit 
and then re-launch the Sonar application. 
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Configuring Sonar Home Studio 4 to use the ASIO TonePort driver 

Launch the Sonar Home Studio application and make the following settings… 
 

 

Select the Sonar 
Options menu and 
choose Audio 
 

 
 

 
 

 
 
 

 
 
 
 
 

 
Once the Sonar Home Studio 4 application is launched again… 
 

 

Select the 
Advanced tab 
 
 
 
 
 
Select ASIO as  
the Driver Mode 

Click the OK button when 
done 

If prompted with the following dialog, click the OK button …  

You must now exit the Sonar application, and then launch Sonar Home Studio again for the 
ASIO setting to take effect! 

Return to the Sonar Options 
menu and choose Audio to 
launch the Audio Options 
dialog once again 

 07-05-2006 Page 142



  
  GearBox 1.02 – Recording Setup Guide 

 
 
 

 

Select the Drivers tab 
 
Make sure all Input 
Drivers are enabled if 
you want to record 
from all TonePort’s 
Sends 
 
Also enable the Output 
Driver 

 
 

 

Select the General tab and match 
all settings as shown in this 
example 
 
Choose a different Sample Rate if 
your Projects require it, otherwise 
44100 is a good choice 
 
Choose 24 as the File Bit Depth 
 
Be sure to click the dialog’s OK 
button when done. 
 
 

 
 
 

 

Setting up an audio track to record from TonePort in Sonar Home Studio 4 

Now that your TonePort hardware is set up, open or create a new Sonar Project and make the 
following settings to start recording… 
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At the left of the track, click 
on the track Input Selector 
and choose the preferred 
TonePort Send  
 

 
 
 

 
 

 
 
 
 
 
 
 
 
 

 
 

 

 
 

 
__________________________________________________________________________________ 

 

Click 
on the 
desired 
audio 

Arm 
track’s 

button

Note that the “Left” and “Right” labeled ASIO TonePort Send 1 options will record from 
either the TonePort Send 1 or Send 2, respectively. These “Left” and “Right” labeled 
inputs will each record a mono file.  
 
The “Stereo” labeled options will record from the TonePort Send 1 & 2, or Send 3 & 4, 
and will each record a stereo file.  

Click on the desired audio 
track’s Arm button to arm the 
track for recording.  
The track Input Meter will 
reflect the input level 

Now press the 
main transport 
Record button 
and start 
recording! 
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CAKEWALK SONAR 4 PRODUCER/STUDIO SETUP - WINDOWS® 

Be sure to connect the USB cable from TonePort into your computer’s USB port, and then proceed with 
the following steps… 

 

Configuring TonePort’s Control Console 

First launch the GearBox application, and go to the Help menu to launch the TonePort Control 
Console. 
 

 

Select the GearBox Help menu 
 
Choose Hardware & Driver Settings 

 

Match the settings in the Control Console dialog as shown here… 

 

 

Select your 
TonePort UX1  

(or UX2) device 

 

 

Configuring Sonar 4 to use the ASIO TonePort driver 

Launch the Sonar 4 application and make the following settings… 
 

 
 
 
 
 
 
Select 24 bit 
 
 
Click Apply when 
done  

 07-05-2006 Page 145



  
  GearBox 1.02 – Recording Setup Guide 

 

 

Select the Sonar 
Options menu and 
choose Audio 
 

 
 
 

 
 
 
 
 
 

 
 
You must now exit the Sonar application, and then launch Sonar 4 Studio/Producer again for the 
ASIO setting to take effect. 
 
 
 

 

Once the Sonar 4 Studio/Producer application is launched again… 

 

Select the 
Advanced tab 
 
 
 
 
 
Select ASIO as  
the Driver Mode 

Click the OK 
button when done 

If prompted, click the OK button…
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Return to the Sonar Options 
menu and choose Audio to 
launch the Audio Options 
dialog once again 

 
 

 

Select the Drivers tab 
 
Make sure all Input Drivers are 

enabled if you want to record 
from all TonePort’s Sends 

 
 
 
 
Also enable the Output Driver 

 
 

 

Select the General tab and match 
all settings as shown in this 
example 
 
Choose a different Sample Rate if 
your Projects require it, otherwise 
44100 is a good choice 
 
Choose 24 as the File Bit Depth 
 
Be sure to click the dialog’s OK 
button when done. 
 
This completes the ASIO driver 
setup!  

Setting up an audio track to record from TonePort in Sonar 4  
 
 
 
Now that your TonePort hardware is set up, open or create a new Sonar Project and make the 
following settings to start recording… 
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Click on the Input 
Selector at the left 
of the audio track 
and choose the 
preferred TonePort 
Send  

 
 

Note that the “Left” and “Right” labeled ASIO TonePort Send 1-2 options will record from 
either the TonePort Send 1 or Send 2, respectively. These “Left” and “Right” labeled inputs 
will record a mono file.  
 
The “Stereo” labeled options will record from TonePort’s Send 1 & 2, or Send 3 & 4, and will 
record a stereo file. 

 
 
 

 
 

 
 

 
 
__________________________________________________________________________________ 
 

Now press the 
main 
transport 
Record button 
and start 
recording! 

Click on the audio track’s 
Arm button to arm the track 
for recording.  
 
The track Input Meter will 
reflect the input level 
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DIGIDESIGN PRO TOOLS LE 6 SETUP – WINDOWS® 

Using TonePort with Pro Tools LE 6.x 

Digidesign has designed Pro Tools software so it can only be used with a Digidesign or M-Audio audio 
interface; you cannot use TonePort as the primary audio interface for a Pro Tools system. But you can 
still enjoy the benefits of TonePort and GearBox by connecting TonePort to your Digidesign 
interface's inputs. TonePort UX2 even lets you do this with a direct, digital connection. 
 
For this document, we’ll be showing how to connect to the Digidesign Mbox unit, but these steps are 
similar for connecting to the Digi 002 or other Digidesign hardware as well. There are two methods 
described here – Recording from TonePort UX1 or UX2’s analog outputs, and recording from 
TonePort UX2’s digital S/PDIF output.  
 

Note that it is not necessary to have both your TonePort and Mbox units connected to the 
same PC. You can alternatively have your TonePort and Digidesign hardware on separate 
computers as well, since the two devices are indeed operating individually! 

 
Be sure to connect the USB cable from TonePort into your computer’s USB port, and then proceed 
with the following steps… 
       
      

Recording from TonePort UX1 or UX2’s Analog Outputs 

 
Connect the analog outputs from TonePort to the Digidesign Mbox 
 

 

Using two ¼” to ¼” shielded TS or TRS 
audio cables, plug each into the Analog 
Outs of your TonePort UX1  
(or UX2) device 
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Plug the other end of the left audio cable into the Mbox 
Source 1 input, and the right audio cable into the Mbox 
Source 2 input. 

From TonePort Right Analog Out 
  

 
 

From TonePort Left Analog Out 

 
 
 
 
 
 
 

You will still use the Mbox Line Outputs (or Headphone Output) to hear playback of all Pro Tools 
LE audio. The TonePort/GearBox audio will now be mixed with the Pro Tools LE audio as well. 
Therefore, if you are using headphones, you’ll want to plug them into the Mbox headphone jack to 
hear everything. 

 
 
 
 
Next, before you launch Pro Tools LE, launch the GearBox application, and go to the Help menu to 
launch the TonePort Control Console. 
 
 

Select the GearBox Help menu 

 

 
Choose Hardware & Driver Settings 
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Match all settings in the TonePort Control Console dialog, as shown here… 
 

 

Select your TonePort 
UX1  

 
 
 
 

 

To start a new session in Pro Tools LE, choose 
New Session from the File menu 

Choose 44.1 kHz or  
48 kHz  
 
 
 
Choose 24 Bit  
 
Type in a File name and 
click the Save button 

(or UX2) device 
 
Check the Force 
TonePort/GearBox 
format checkbox, and 
then choose 44.1KHz 
and 24 bit 
 
 
Click Apply when 
done. (Do not exit the 
GearBox application). 

Now, launch Pro Tools LE and create a new Session…
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Set up a new Pro Tools LE track for recording… 
 

 

Now that you have a new session, 
choose New Tracks from the File 
menu 

 

 
 
 
 
 

 

Choose how many Choose Mono or Stereo for 
your audio track format 

Click the Create 
button Tracks to create  

 
 

 

At the top left of the Edit Window, click the View 
selector and enable the I/O View 
 

 
 
 If the track you want to record into is Stereo, click on the track’s Input button and 

choose Interface > Mic/Line 1-2 (Stereo)  
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Or… if the track you want to record into is Mono, click on the track’s Input button and 
choose Mic/Line 1 (Mono) to capture the TonePort LEFT signal, or choose Mic/Line 2 
(Mono) to capture the TonePort RIGHT signal 
 

 
 
 
 

Click the Arm button 
for the track to arm it 
for recording  

 

Click the Mute button 
to mute the track 
while recording*  
 The track meters will 

now measure the 
TonePort/GearBox 
input signal level  

 

 
 
 
 
 
 
 
 

* Muting the track during recording disables the Pro Tools LE software monitoring feature, 
which allows your TonePort/GearBox analog input signal to be monitored with the lowest 
latency possible. Adjust the Mbox Mix knob to balance the session audio with the input audio 
(see your Mbox documentation for details). 

 
Note to Digi 002 users… when using the Digi 002 hardware with Pro Tools LE, an additional Low 
Latency Monitoring option is available within Pro Tools LE Operations menu. You can alternatively 
keep your track un-muted and activate this option to hear your input monitoring signal when 
recording (see your Digi 002/Pro Tools LE documentation for more on this feature). 
 
 

 

Set the Source 1 and 
Source 2 to “Line” 
input  

The Source 1 & 2 Gain 
knobs will now adjust 
the recording input 
level coming into the 
Mbox from 
TonePort/GearBox* 
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Start recording… 
 

 

Click the transport 
Record button to 
place Pro Tools LE 
into record mode, 
then press the Play 
button to start 
recording!  

 
 
 
 

Recording from TonePort UX2’s S/PDIF Digital Output 

 
 
Connect the TonePort UX2 S/PDIF output to the Digidesign Mbox  
 

 

Using a 75-Ohm, coaxial S/PDIF cable, plug one end 
into the S/PDIF Digital Out of your TonePort UX2… 
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Plug the other end of the S/PDIF cable into the   
Mbox S/PDIF In  

 

 
 
 
 
 
 
 

You will still use the Mbox Line Outputs (or Headphone Output) to hear playback of all Pro 
Tools LE audio. The TonePort/GearBox audio will now be mixed with the Pro Tools LE audio if 
you use the Pro Tools software monitoring function. See the later section regarding monitoring 
for more on this. 

 
 
 
Next, before launching Pro Tools LE, launch the GearBox application, and go to the Help menu to 
launch the TonePort Control Console. 
 
 

 

Select the GearBox Help menu and 
choose Hardware & Driver Settings 
 

 
 
 
 
 
 
Match all settings in the TonePort Control Console dialog, as shown here… 
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Select your TonePort 
UX2 device  
 
Check the Force 
format box and 
choose 44.1KHz and 
24 bit 

 
 
Now, launch the Pro Tools LE application and set it up to receive the S/PDIF Digital Input 
 

 

 
 

 
 
 
Click Apply 
Do not exit the 
GearBox application 
 

Go to the Pro Tools LE 
Setups menu and choose 
Hardware Setup 

Choose S/PDIF as the Input 
Source 
 
The Clock setting will 
automatically also change to 
S/PDIF – keep this setting for 
recording since this syncs the 
Mbox to TonePort’s clock. 
 
Click OK when done 
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Note that when receiving 
S/PDIF input, the Source 1 & 
Source 2 Gain knobs do not 
adjust the digital signal level  
 
To adjust the recording level, 
use the GearBox software’s 
output level controls 

You will now see the spdif 
light illuminated on the 
front of the Mbox, 
indicating it is in S/PDIF 
digital input mode 

 
Create a new Pro Tools LE Session… 
 

 

Go to the File menu and choose New Session 

Choose 44.1 kHz* 
 
 
 
Choose 24 Bit  
 
Type in a File name 
and click Save  
 

 
 

 

*If you prefer to use the 48 kHz Sample Rate, then you can choose these here in the Pro Tools dialog, 
but you will need to also go back to the TonePort Control Console dialog and set these values to match 
(see the earlier step on configuring the TonePort Control Console). Matching sample rates are required 
with a digital connection. 
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Create a new Pro Tools LE track for recording… 
 

 

Now that you have a new session, 
choose New Tracks from the File 
menu 
 

 

 
 
 
 
 
 

Choose Mono or Stereo for 
your audio track format 

Choose how many Click the Create 
button Tracks to create  

 

 

 

At the top left of the Edit Window, click the View 
selector and enable the I/O View 
 

 
 

If the track you want to record into is Stereo, click on the track’s Input button and 
choose Interface > Mic/Line 1-2 (Stereo) 
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Or… if the track you want to record into is Mono, click on the track’s Input button and 
choose Mic/Line 1 (Mono) to capture the TonePort LEFT signal, or choose Mic/Line 2 
(Mono) to capture the TonePort RIGHT signal 
 

 
 
 

 
 

Click the Arm button 
for the track to arm it 
for recording  

Keep the track’s Mute 
button set to un-muted to 
monitor your 
TonePort/GearBox 
signal* 

 
The track meters will 
now measure the 
TonePort/GearBox 
input signal level  

 
 

 

 
 
 
 
 
 
 
 

* When receiving a S/PDIF input, the Mbox will only allow the signal to be monitored through the 
Pro Tools LE software. The track’s volume control will adjust the monitor signal coming from your 
TonePort/Gearbox, allowing you to balance your listening levels independently of your recording 
level. The Pro Tools LE software monitoring is also subject to latency, which is affected by your Pro 
Tools LE Hardware Buffer settings (see your Mbox documentation for more information regarding 
latency and monitoring). 

 
 
Note to Digi 002 users… when using the Digi 002 hardware with Pro Tools LE, an additional Low 
Latency Monitoring option is available in the Pro Tools LE Operations menu. It is best to activate 
this option to hear your input monitoring signal with the lowest latency when recording (see your 
Digi 002/Pro Tools LE documentation for more about this feature). 
 
 
Adjust the Pro Tools LE Hardware Buffers 
 

 

Go to the Pro Tools LE Setups menu and 
choose Playback Engine  
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The lower the H/W Buffer Size 
value that is selected, the lower 
the latency. However, lower 
values also result in less 
stability for session playback 
and recording. 256 Samples 
may be a good starting value to 
try. 
 
Click OK when done  

 
Note – this Buffer Size value does not affect the monitoring latency when using the Digi 002 and the “Low 
Latency Monitoring” option. 
 
 
 
 
 
 
 
 
 

Alternative Mbox monitoring option…If monitoring your TonePort recording signal through the 
Pro Tools LE software results in excessive latency, you can alternatively connect TonePort’s Analog 
Outs to an external Mixing Console and manually mix the TonePort signal with the output of your 
Mbox. This allows you to hear the TonePort signal with no added latency from Pro Tools LE. In this 
configuration, you should Mute your Pro Tools LE track while recording to silence its software 
monitoring signal.  

 
 

Start recording… 
 

 
 
 
 
 
 
__________________________________________________________________________________ 

Now click the transport Record button to place Pro Tools LE into record mode, 
then press the Play button to start recording!  
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PROPELLERHEAD REASON 3 SETUP – WINDOWS® 

Propellerhead Software’s Reason 3 is an amazing virtual studio filled with synthesizers, drums and effects, 
all combined with a MIDI sequencer for easy pattern-based music creation. Reason does not offer a 
feature for recording audio; therefore, GearBox and TonePort cannot be used for input directly into 
Reason. However, you do of course need a sound card device for playback, and TonePort is a perfect high 
quality interface for this task! When using TonePort, you can also simultaneously plug in your 
instruments and jam along with the playback of your Reason project, or utilize Reason’s ReWire 
technology to combine a Reason project with that of another ReWire capable audio software, and use 
TonePort as the audio device in this setup as well.   
 
Be sure to connect the USB cable from TonePort into your computer’s USB port, and then proceed with 
the following steps… 

 

Use TonePort as your playback device for Reason 3 

 
Configure TonePort for Reason playback 
First launch the GearBox application to launch the TonePort Control Console. 
 

 

Select the GearBox Help menu 
 
Choose Hardware & Driver Settings 

 

 

Select your 
TonePort UX1  
(or UX2) device 
 
 
 
 
 
 
 
 
 
Select 24 bit* 
 
 
Click Apply when 
done  
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*Note – you must choose 24 bit or 16 bit, (24 bit is preferred for the best audio quality). Reason 
3 does not support 32 bit and no audio will be heard with this setting. 
 

Configuring Reason 3 to use the ASIO TonePort driver 
Launch Ableton Live Lite 4 and make the following settings… 
 

 

Select the Reason Edit 
menu and choose 
Preferences 
 

 
  

 

Select the Audio Page 
 
Choose ASIO TonePort UX1 (or 
UX2) as the 
Audio Card Driver * 
 
Choose a Sample Rate – 44100 is 
a good choice for most projects  
 
 
Click the X button at the top 
right of the Preferences dialog 
when done to exit 
 
 

 
 
 
 
 

* Note – You will also see options for DX Line 6 TonePort and MME Line 6 TonePort 
within the Audio Card Driver menu. These are alternative driver types that can be used, but 
it is recommended to select the ASIO TonePort driver for the best performance.  
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You should now see your TonePort listed 
as the Audio Out device at the top left of 
Reason’s display 

 
 

 

Now just hit the Play button in Reason’s 
transport and to hear the Reason 
playback through TonePort! 

 
 
To jam along with Reason… 
You can also of course still use GearBox for your Mic and Instrument tones while Reason is playing 
back if you want to sing or jam along. Just plug in your Mic or Instrument and use GearBox just as you 
normally do. Note that you can use the Send 1-2 Monitor knob to adjust the level of your Mic or 
Instrument independently of the level of the Reason playback. 
 

 

Use the Send 1-2 Monitor knob to adjust 
your Mic and Instrument volume level 

      
 
To control the playback level of Reason, use the Mixer controls in the Reason software 
 

 

Use the Reason Mixer’s Master slider for 
overall control of Reason’s playback level. 
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With this configuration, both the Reason project playback, and your Mic/Instrument GearBox tones 
are heard through your speakers, and sent to all TonePort’s outputs. This allows you to connect any of 
TonePort’s outputs to any external device, such as a tape recorder, mixer, P.A. system, etc. to record 
or amplify this stereo output signal! 
 
 
 

Using TonePort with Reason 3 in a ReWire setup 

The Propellerhead “ReWire” technology allows the Reason modules’ outputs to be directly routed into 
any ReWire “Host” application. Using ReWire, the Host application can send MIDI tracks to Reason’s 
synth. modules, and Reason then sends audio playback directly into the ReWire Host, which is mixed 
with the audio of the Host application. When Reason is configured as a ReWire “Slave” in this manner, 
it is controlled by the Host application and does not utilize a sound card connection itself. Therefore, if 
you want to use TonePort as your sound card device in a ReWire setup like this, it is necessary for you to 
choose TonePort as the audio device for the ReWire Host application.  

 
 
Using Reason 3 with Ableton Live Lite 4 as a ReWire Host 
The included Ableton Live Lite 4 software is capable of functioning as a ReWire Host application. 
The following steps show you how to set TonePort as the audio device for the Ableton Live Lite 4 
software, and then configure Live to connect with Reason as a ReWire Slave device. This allows you 
to do audio recording and playback with Ableton Live, allowing Reason’s output to be automatically 
played in sync and channeled through Live’s audio tracks via ReWire. 
 
You first want to be sure to exit Reason if it is currently running. The ReWire Host application must 
be launched first. Launch Ableton Live Lite 4 and make the following settings to set TonePort as the 
Live audio device… 
 
 
 

 

Select the Live Options 
menu and choose 
Preferences 
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  Select the Audio tab 

 

 
 
 
 
Choose ASIO as the 
Driver Type 

 

 

Select  
ASIO TonePort UX1 
(or UX2) as the Audio 
Device 

    
 
Now that Ableton Live Lite 4 is configured to use TonePort, launch Reason 3. Reason will 
automatically set itself to ReWire Slave Mode. You can check this mode in the Reason Hardware 
Interface module’s Audio Out section. 
 

 

Reason 3 detects when an available ReWire 
Master is running and sets itself to Slave mode 

 
 
 
Now in Ableton Live, you can simply access the Output menu of any MIDI track to set it to send its 
MIDI to any of the Reason synth modules. 
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In any of Live’s MIDI tracks, choose Reason 
as the MIDI To output, and then click on 
the Output Channel selector to choose any 
Reason module 

 
 To receive the audio output from Reason, set the Input of any of Live’s audio tracks to receive the 
audio from any of Reason’s outputs. 
 

 

In any of Live’s Audio tracks, choose Reason as 
the Audio From input, and then click on the 
Input Channel selector to choose any Reason 
output channels 
 
(Note that the 1/2 Mix, Mix R channel receives 
the full Reason project audio mix) 

 
 
 Now just hit the Play button in either Live 

or Reason, and both projects will play in 
sync, with all the audio being routed into 
Ableton Live Lite 4 and played through 
TonePort! 

 

 
 

 
 
You can utilize GearBox and TonePort to also plug in a Mic or Instrument, dial in your tone, and 
record audio tracks right into the Ableton Live Lite 4 Set. It is important to note, however, that 
running all these programs at one time can require some hefty usage of your computers processor, 
RAM and disk access, especially as you add more tracks, synth modules and real-time effects. Your 
actual performance will depend on the specifications of your computer.  
 

_____________________________________________________________________________________ 
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STEINBERG CUBASE SE 1.0.7 SETUP – WINDOWS® 

Be sure to connect the USB cable from TonePort into your computer’s USB port, and then proceed with 
the following steps… 

 

Configuring TonePort’s Control Console 

First launch the GearBox application, and then go to the Help menu to launch the TonePort Control 
Console. 
 
 

 

Select the GearBox Help menu 
 
Choose Hardware & Driver Settings 

 
 
Match all settings in the Control Console dialog as shown here… 
 

 

Select your 
TonePort UX1  

 
 
 

Configuring Cubase SE to use the ASIO TonePort driver 

Launch Cubase SE and make the following settings… 
 

(or UX2) device 
 
 
 
 
 
 
 
 
Select 32 bit 
 
 
Click Apply when 
done  
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If this ASIO Multimedia 
dialog is displayed, click 
Yes to allow it to run its 
configuration test 

    
 

 

Once the configuration test 
completes, go to the Cubase SE 
Devices menu and select 
Device Setup 

 
 Select the VST 

Multitrack option, and 
choose the Setup tab in 
the right of the dialog 
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Select ASIO TonePort 
UX1 (or UX2) as the 
ASIO Driver 

 
 

 

 

Select Switch when 
prompted if you want to 
switch the ASIO driver 

 
 
 
 

 

Select the OK button to 
exit the Device Setup 
dialog 
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Next, select the Cubase  
SE Devices menu and 
choose VST Inputs 

 

 

Press the power button for Send 3 and 
Send 4 to activate them if you want to 
record from these TonePort Sends 
 

 
 
 

Preparing a Cubase SE Project for recording 

Now that the TonePort hardware is set up, you are ready to start working in a Cubase SE Project!  
 

 

Check your Project’s Sample 
Rate and Bit Resolution – these 
are displayed at the bottom left 
of the Cubase Project window: 

 
 
44,100 Hz Sample Rate and 24 Bit are good recording settings for most Projects, but if you have 
specific requirements, these can be changed…  
 
 

 

To change the Sample Rate or 
Bit Resolution, select the 
Project menu and choose 
Project Setup 
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Choose different Sample 
Rate and Bit Resolution in 
these pop-ups, if desired 
 
Click the OK button to exit 
the dialog  

 
 
 

Setting up an audio track to record from TonePort 

Cubase SE’s Audio track settings can be accessed easily in the Inspector pane at the left of the Project 
window. 
 
 
Stereo recording  
To record into the selected audio track from the TonePort Send 1 and Send 2 as a stereo file, set the 
Inspector as follows: 
 Armed for recording  

 

 
Input Monitoring OFF* 
 
Stereo 
 
Input from IN 1+IN 2 
(TonePort Send 1 & 2) 
 
Playback out to BUS 1 
(TonePort)

 
 

Mono recording  
To record into the selected audio track from any TonePort Send as a mono file, set the Inspector as 
follows: 
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________________________________________________________________________________ 
 

Mono 
 
Select any individual 
Send as the recording 
source 

*Note that the track meters in Cubase will not measure the input signal when Input Monitoring 
is off. You can use the Send meters in the GearBox software as your signal level reference. 

Now just click the 
Transport Record 
button and start 
recording!  
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STEINBERG CUBASE SX/SL 3 SETUP - WINDOWS® 

Be sure to connect the USB cable from TonePort into your computer’s USB port, and then proceed with 
the following steps… 

 

Configuring TonePort’s Control Console 

First launch the GearBox application, and then go to the Help menu to launch the TonePort Control 
Console. 
 

 

Select the GearBox Help menu 
 
Choose Hardware & Driver Settings 

 
 
Match all settings in the Control Console dialog as shown here… 
 

 

Select your 
TonePort UX1  

 
 

Configuring Cubase SX/SL 3 to use the ASIO TonePort driver 

Launch Cubase and make the following settings… 
 
 

(or UX2) device 
 
 
 
 
 
 
 
 
Select 32 bit 
 
 
Click Apply when 
done  
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If this ASIO Multimedia 
dialog is displayed, click 
OK to allow it to run its 
configuration test 

 
 

 

Once the configuration test 
completes, go to the Cubase Devices 
menu and select Device Setup 

 
 

 

Select VST 
Audiobay within 
the Devices 
pane… 
 

Then select ASIO TonePort UX1 (or UX2) as 
the Master ASIO Driver 
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Select Switch if you are 
prompted to select another 
driver… 
 
Then click OK to exit the 
Cubase Device Setup dialog 

 
 
 

Configuring Cubase SX/SL 3 to use ASIO TonePort Inputs and Outputs 

Proceed with the following steps to establish TonePort’s Sends as Inputs for Cubase… 
 
 

 

Go to the Cubase Devices menu and choose VST 
Connections 

 
 

Choose the Inputs tab 

 

 
In this window you 
can create an input 
“Bus” for each possible 
Stereo and Mono 
Send combination 
coming from 
TonePort. The Bus 
Name can also be 
edited for each 
 
All Buses listed in this 
tab will appear as 
Inputs within Cubase 
when choosing the 
recording input for an 
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For more information on creating and configuring Inputs, please check the Cubase SX/SL 3 
documentation 

If no Buses yet exist in this list 
that use your ASIO TonePort 
audio device, then you must create 
at least one Bus… 
 
Click on the Add Bus button.  
 
Select Stereo or Mono.  
 
Click OK in the Add Input Bus 
window. 

Click on the individual 
Device Port entries for 
each Bus to set them to 
the preferred TonePort 
Send  
 
You can repeat these 
steps to create a Bus for 
each TonePort Send 

Exit the VST Connections dialog by clicking on the X 
button when settings are completed  

Click the Outputs tab 
 
If a Stereo Bus does not yet 
exist for your ASIO 
TonePort Audio Device as 
shown here, then use the 
Add Bus option to create a 
Stereo Bus, following the 
same steps listed above  
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Preparing a Cubase SX/SL 3 Project for recording 

Now that the TonePort hardware is set up, you are ready to start working in a Cubase Project!  
 
 

Check your Cubase Project’s 
Sample Rate and Bit 
Resolution – these are 
displayed at the bottom left of 
the Cubase Project window: 

 
 
44,100 Hz Sample Rate and 24 Bit are good recording settings for most Projects, but if you have 
specific requirements, these can be changed…  
 
 

 

Select the Cubase Project 
menu and choose Project Setup 

 
 

 

Choose different Sample 
Rate and Bit Resolution in 
these pop-ups, if desired 

 

  
Click the OK button to exit 
the dialog 
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Setting up an audio track to record from TonePort 

 

 

To create a new audio track, go to 
the Project menu and choose Add 
Track > Audio 

 

Choose Mono or Stereo for your 
desired recording track type 

 
The Cubase Audio track settings can be accessed easily in the Inspector pane at the left of the Project 
window. Match the settings shown here… 
 

Armed for recording  

 

 
Input Monitoring OFF* 
 
Record from your desired ASIO 
TonePort Input Bus 
 
Playback out to your configured 
ASIO TonePort Output Bus 

*Note that the track meters in Cubase will not measure the 
input signal unless the Input Monitoring feature is on. You 
can refer to the Send meters in the GearBox software as 
your signal level reference. 

 
Now just click the Transport 
Record button and start 
recording!  
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